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Uber uns

»Aus der Praxis fiir die Praxis“

bedeutet bei medienreich eine effiziente und
konkrete Wissensvermittlung, die Sie im profes-
sionellen Einsatz bendtigen. Denn in der Praxis
der digitalen Medien ist die Beherrschung der
Software und entsprechendes Hintergrundwissen
unverzichtbar.

Unsere Trainer/-innen

kommen aus Medienunternehmen und kennen
die Tricks und Kniffe der Software aus der tag-
lichen Arbeit. Die Trainer vermitteln ihr Know-how
an realistischen und praxisorientierten Aufgaben
und Szenarien.

Unsere modernen Trainingsraume

mit PC-Einzelschulungsplatzen sind mit
modernster Multimediatechnik ausgestattet.
In den Pausen stehen Getranke und Snacks
bereit und zum Mittagessen laden wir unsere
Teilnehmer/-innen in ein nahegelegenes
Restaurant ein.

Viele zufriedene Kunden
Uberzeugten sich bereits von der Qualitat unserer
Trainings.

Starten Sie in lhre erfolgreiche Zukunft.
Wir unterstiitzen Sie dabei.

Mit freundlichen GriBen
lhr medienreich-Team

und
Frank Schmittat
Geschéftsleitung
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Was Sie wissen sollten

Unsere Trainings sind fur Personen konzipiert,
die effizient und praxisorientiert neue Programme
und Anwendungen kennenlernen méchten.

Durch die hohen Praxisanteile in unseren Trai-
nings sind Sie in der Lage, das Gelernte miihelos
in lhre tagliche Arbeit zu integrieren und dort
anzuwenden.

Unabhangig davon, ob Sie Anfanger sind, Gber
Grundlagenwissen verfligen oder schon fort-
geschrittene Kenntnisse besitzen, bietet lhnen
medienreich Computertrainings eine erfolgreiche
Qualifikation fiir lhre Zukunft.

Foto: pressmaster@fotolia.com

Das Trainingsangebot

Neben den hier abgebildeten TOP 100 Trainings
haben wir noch viele weitere Trainings in unserem
Trainingsangebot. Auf unserer Webseite finden
Sie Gber 1.000 Trainings aus den Bereichen
Grafik, Multimedia, CAD, Office, Programmierung,
Datenbanken, Server, Betriebssysteme, Internet
und Marketing.

Besuchen Sie uns unter:
www.medienreich.com



lhre Vorteile

Rabattsystem:
Bei gleichzeitiger Anmeldung von mehreren Per-
sonen zu einem Training gewahren wir folgende

Rabatte*:

2 - 3 Personen: 5%
4 - 6 Personen: 10 %
ab 7 Personen: 15 %

Die Sammelanmeldung ist nur giiltig, wenn sie
von einer anmeldenden Person/Stelle erfolgt und
eine Sammelrechnung erstellt wird.

Treuerabatte:

Fiir Teilnehmer/-innen oder Firmen, die innerhalb
eines Jahres bei medienreich verschiedene Trai-
nings buchen, gewéahren wir folgende Rabatte* fiir
die Teilnahme am

2. - 3. Training: 5%
4. -5, Training: 10 %
und ab dem 6. Training: 15 %

Investitionsgarantie:

Scheidet ein/-e Teilnehmer/-in innerhalb der
ersten 6 Monate nach dem Besuch eines unserer
Trainings nachweislich aus dem Unternehmen
aus, kann der/die direkte Nachfolger/-in innerhalb
eines halben Jahres kostenfrei an einem offenen
Training gleichen Themas teilnehmen.

Zufriedenheitsgarantie:

Sie haben die Mdglichkeit am ersten Trainings-
morgen zu entscheiden, ob der Kurs fiir Sie der
richtige ist. Falls nicht, kdnnen Sie selbstver-
standlich eine Neuauswabhl treffen.

Zertifizierung:

medienreich ist zertifizierter Trainingspartner
von Adobe, Autodesk und Microsoft Partner
Silver Learning. Nur ausgewahlte Unternehmen
mit einem sehr hohen Qualitatsniveau erhalten
diese Zertifizierung - Ihr Garant fir eine kompe-
tente Wissensvermittlung.

Kontinuierliche Qualitatskontrolle:

Jedes Training wird von den Teilnehmern anhand
eines ausfihrlichen Fragebogens bewertet. Eine
sorgféltige Analyse dieser Bewertung gibt uns die
Mdglichkeit, unsere Veranstaltungen standig auf
hohem Niveau zu halten und zu verbessern.

* Bitte beachten Sie, dass wir nur ein Rabattsystem gleichzeitig
gewdhren kénnen.
Die genannten Rabattsysteme gelten nur fir Trainings aus
unserem offenen Trainingsprogramm.

Wir beraten Sie gerne unter 0800 - 5550116 (kostenfreie Beratungshotline)



Teilnehmer iiber medienreich

Deutscher Bundestag

Adobe InDesign

»Mir hat besonders gefallen, wie unser Dozent sein
Wissen an die Frau bzw. den Mann gebracht hat.
Es war auch far einen ,Neueinsteiger* wie mich ver-
standlich und nie langweilig.”

Stréer Infoscreen

Cinema 4D

»In kurzer Zeit wurde viel Wissen sehr effektiv ver-
mittelt — dazu hat das Seminar auch noch Spal3
gemacht, da der Dozent nicht nur kompetent und
aufmerksam, sondern auch noch sehr nett war.
Auf Fragen und auf Gegebenheiten der Arbeits-
situation wurde ebenfalls geduldigst eingegangen.
GroBe Empfehlung!*

Deutsche Boérse Systems AG

FrameMaker

»~Seminar, Ort und Dozent kann ich bedenkenlos
weiterempfehlen. Ich habe selten ein so gutes
Seminar erlebt! Der Dozent hatte ein sehr umfang-
reiches Wissen, konnte dies sehr gut weitergeben
und ist sehr auf spezielle Fragen der Teilnehmer
eingegangen. Rundum ein sehr gutes Seminar!*

Apple GmbH

Controlling mit Excel

»Kleine Gruppen, dadurch konnte Stoff wesentlich
vertieft werden. Dozent beantwortete auch Fragen,
die nicht Gegenstand des Trainings waren, aber flr
meinen Arbeitsalltag sehr wichtig, duBerst zufrie-
denstellend und gab auch ansonsten sehr gute
Anregungen.”

Miele

PowerPoint Aufbau

~Super Dozentin, Zweiertraining war unheimlich
effektiv und vor allem individuell. Besonders die vie-
len Tipps und Tricks am Rande. medienreich kann
man nur empfehlen.”

Referenzen

Auch Mitarbeiter/-innen folgender Unternehmen
nutzen medienreich Computertrainings fir ihre
Weiterbildung:

AOK

Audi AG

Bayer AG

Bertelsmann SE & Co. KGaA
Continental AG

debis Systemhaus GmbH
Deutsche Bank AG

Deutsche Borse AG
Deutsche Post AG
Deutscher Bundestag
Deutsche Telekom AG
Disney Publishing Worldwide
Dresdner Bank

E.ON AG

Franklin Templeton Investments
Fujitsu Siemens AG
Globalpark GmbH

IBM GmbH

Kabel Deutschland
Kassenérztliche Bundesvereinigung
Lotto Toto GmbH

Lufthansa
Niederséachsisches Umweltministerium
Nintendo

Oracle Corp.

Pixelpark AG

Rentex Vertriebs GmbH
Rheinische Kliniken

SAP AG

Schueco KG

Stadt Miinchen

Staedtler

Siemens AG

Techniker Krankenkasse
Toshiba Europa GmbH
Universal Studios Networks
Vodafone-D2 GmbH
Volkswagen AG

u.v.a.

Wir beraten Sie gerne unter 0800 - 5550116 (kostenfreie Beratungshotline)
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COMPUTERTRAININGS

Individuelle Trainings

Alle Computerkurse und Schulungen aus unserem
Trainingsangebot sowie viele weitere Themen
bieten wir lhnen auch als individuelle Trainings an.

Inhouse Trainings

> Wir kommen zu lhnen.

> Sie bestimmen den Schulungstermin.

> Schulungsschwerpunkte kénnen individuell aus
unserem Trainingsprogramm gewahlt werden.

Firmen Trainings

> Sie kommen zu uns.

> Individuelle Schulungstermine sind maéglich.

> Schulungsschwerpunkte kénnen individuell aus
unserem Trainingsprogramm gewahlt werden.

Gerne erstellen wir Ihnen ein persénliches Angebot.

Tel.: 0800 - 5550116 kostenfreic Serviceline

Foto: nyul@fotolia.com

Nutzen Sie
eines indivij

die Vorteile
duellen Trainings:

Freie Terminwah)
der Schulung

lndividuelle Betreuung
durch den Trainer

Wir kommen 2u lhnen
oder Sje ZU uns
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Das sind unsere TOP 100 Themen!

Unser gesamtes Kursangebot finden Sie unter www.medienreich.de

AdobeInDesign ............. i 12
Adobe Photoshop . ..o 12
Adobe lllustrator ............. ... i 13
Print- u. Layoutdesign mit InDesign u. Photoshop. ...... 13
Adobe After Effects ..., 14
Adobe FrameMaker . ..., 14
Adobe LiveCycle Designer . ..........ccovivenneen.. 15
Adobe Premiere . ... 15
Adobe Dreamweaver . ............c.ccoviiininiaenn. 16
Adobe Captivate ..............coiiiiiiiinnnnnnn. 16
CorelDRAW ... et e 18
QUArkXPress .. ...cvvveeniiiiiiiiiiiieieeeaeanns 18
Final CutPro ......... ... 19
CorelDRAW Technical Suite . . ...................... 19
Logo-Design mit CorelDRAW .. ..................... 20
Farbmanagement ............. ... .. .. i, 20

3D-VISUALISIERUNG - CAD

Autodesk AutoCAD - Grundlagen — Aufbau . ........... 22
Autodesk Inventor — Grundlagen — Aufbau ............ 22
Autodesk 3ds Max — Grundlagen — Aufbau ............ 23
CINEMAAD ...ttt 23
3D-Visualisierung mit CINEMA 4D und After Effects ....24
Nemetschek Allplan — Grundlagen — Aufbau . .......... 24

BUROANWENDUNGEN - MS OFFICE

Microsoft Excel — Programmierung mitVBA . .......... 26
MicrosoftExcel ............ccoiiiiiii ity 26
Microsoft Project . ... 27
Microsoft Office — Update auf Version 2013 ........... 27
Microsoft PowerPoint .................... ... ... 28
Microsoft ACCeSS . .. ..o i 28
Microsoft Access — Datenbankentwicklung. ........... 29
Microsoft Qutlook ..............coiiiiiiiiint, 29
Microsoft Visio . ... 30
MicrosoftWord .......... ... 30

BUROANWENDUNGEN — SONSTIGE

MindManager .............c.c.iiiiiiiiiiii 32
LotusNotes ......... ... 32
think-cell ..........cco i 33
OpenOffice —Im Uberblick . . . ......ovvvveinennnns 33
IBM SPSS Statistics ................ ..ot 34
DasiPadundKeynote. .............. ... .. ... ..., 34
Microsoft Windows 7 . ...t 36
Microsoft Windows 7 — Umstieg fiir Administratoren . .. .36
Mircosoft Windows 7 — Umstieg fiir Anwender . ........ 37
Effektiver Umstieg auf Windows 8 und Office 2013 ... .. 37
Microsoft Windows 8 — Fiir Anwender................ 38
Microsoft Windows Server 2012 — Administration ...... 38

SOFTWAREENTWICKLUNG

Visual C# — Grundlagen — Aufbau ................... 40
Java - Grundlagen—Aufbau ....................... 40
Visual C++ — Grundlagen —Aufbau . ................. 41
Visual Basic — Grundlagen — Aufbau . ................ |
Perl — Grundlagen —Aufbau. ....................... 42
SharePoint 2010 — Fiir Entwickler . .................. 42
FileMaker .. ...... ... 44
PHP&MYSQL. .. ..ovvee it eans 44
MySQL ... o e 45
Oracle .......ooiiii e 45
PostgreSQL — Fiir Administratoren .................. 46
SQL - Grundlagen und Datenbankdesign. . ............ 46
LinUX. .o e 48
Linux Ubuntu — Administration. ..................... 48
Datei- und Druckserver mit Linux (Samba) ............ 49
Debian GNU/Linux — Administration ................. 49
FTP- und Webserver mit Linux (Apache) .............. 50
UNIX — Grundlagen —Aufbau . ...................... 50

Wir beraten Sie gerne unter 0800 - 5550116 (kostenfreie Beratungshotline)
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"
HTML - Grundlagen — Aufbau ...................... 52 TYPO3 - Fiir Redakteure .............ccovviiinn... 68 E
CSS (Cascading Style Sheets) ...................... 52 Drupal — Fiir Redakteure . ..............ccvvivinn.. 68 ‘u_-:
JavaScript. . ... e 53 Magento — Fiir Entwickler ......................... 69 E
XML - Grundlagen — Aufbau. . ...................... 53 Joomla! — Fiir Anwender .................cooin... 69 ?:
ASPNETMCV 4. . ... 54 WordPress — Fiir Anwender . ....................... 70 |
JAUBIY . oo 54 Shopware — Fiir Anwender. ................ccvunn. 70 ;

Digital Publishing fiir Tablets oderiPads ............. 56 Microsoft SQL Server Administration — Fortschritt . .. ... 72
EPUB mit Adobe InDesignCS6 ..................... 56 VMware ESX ....... .ot 72
WebApps mit HTML5 erstellen. . .................... 57
Microsoft Windows 8 Apps Entwicklung . ............. 57
iPhone/ iPad App-Entwicklung (i0S6.0) .............. 58
Android Apps entwickeln.......................... 58 Internet — Basiswissen. ............. .o, 74

PC—BasSiSWISSEN. ... ovi ittt it ittt eiennnnnnnns 74

ONLINEMARKETING

Google AdWords — Grundlagen ..................... 60
Google AdWords —Aufbau ......................... 60 Datenschutzrecht — Basiswissen.................... 76
Google Analytics — Grundlagen ..................... 61 Juristische Voraussetzungen fiir Cloud Computing. .. ... 76
Google Optimierung . . ........covviiii i 61
Goolgle Optlm!erung - Fiir Programmierer ............ 62
Onlinemarketing...........ccivviiiiiiinnnnn. 62
Kundenorientierte Briefe und E-Mails . ............... 78
Préasentationstraining ............................ 78
Social Media Marketing — Der Einstieg ............... 64
Social Media Monitoring .......................... 64
Facebookmarketing — Fiir Entscheider ............... 65 Konfliktmanagement .............. .. ... ... ... ... 80
GOOGIB+ .« v vt e 65 Zeitmanagement ........... .. ... . i, 80
Google+ Local — Fiir Unternehmen .................. 66
Online Reputationsmanagement .................... 66
Individuelles Trainingsangebot ..................... 81
Anmeldung. ... 82

Uber 1.000 weitere Trainingsthemen finden Sie auf www.medienreich.de

Wir beraten Sie gerne unter 0800 - 5550116 (kostenfreie Beratungshotline) 9
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medienreich Computertrainings ist zertifizierter Trainingsanbieter

Als Adobe Authorized Training Center, Microsoft Partner Silver Learning und Autodesk Authorized
Training Center bieten wir unseren Kunden qualitativ hochwertige Schulungen. Unsere erfahrenen
Trainer fihren die Trainings in den neuesten Programmversionen durch, damit die Aktualitat der
Schulungsinhalte gewahrleistet ist. Um die Nachhaltigkeit der Schulungen zu garantieren, erhalt
jeder Teilnehmer ein vom Hersteller empfohlenes Fachbuch.

B ez
ADOBE ZERTIFIZIERUNG

Nur wenige Schulungsanbieter erhalten diese
wertvolle Auszeichnung. Adobe Authorized
Training Center bieten modern ausgestattete
Schulungsrdume und Trainer, die tUber langjahrige
didaktische Kompetenz und das aktuellste
Fachwissen verfligen. Davon kénnen auch Sie
als Teilnehmer unserer Schulungen profitieren.
medienreich Computertrainings erhalt seit 2009
jahrlich die begehrte Auszeichnung.

Microsoft Partner

Silver Learning

MICROSOFT ZERTIFIZIERUNG

medienreich Computertrainings ist Microsoft
Partner Silver Learning. In einem langer wah-
renden Zertifizierungsprozess wurde unsere
Organisation, die Qualitat unserer Schulungen
und Trainer, bestehende Referenzen und spezi-
fisches Know-how im Umgang mit den offiziellen
Microsoft Kursangeboten von Microsoft ein-
gehend Uberprift und die Qualitat bestéatigt.

Durch die Zertifizierung erhalten unsere Kunden
einen deutlichen Mehrwert: Als IT-Profi und
Entwickler profitieren Sie vom Know-how und
den praktischen Fahigkeiten der in den neuesten
Microsoft-Technologien von Microsoft zertifizier-
ten Trainerinnen und Trainern.

Wir bieten unseren Kunden aktuell ca. 100
verschiedene Schulungen aus dem Bereich
Microsoft Official Courseware (MOC) an und
begleiten Sie so auf dem Weg zur gewtinschten
Zertifizierungsprifung.

{\ AUTODESK

Authorized Training Center

AUTODESK ZERTIFIZIERUNG

medienreich Computertrainings wurde von
Autodesk als Authorized Training Center (ATC)
zertifiziert. Das garantiert unseren Kunden eine
hohe Trainingsqualitét. Die Teilnehmer werden
von zertifizierten Trainern in den neuesten
Programmversionen geschult und bekommen
von Autodesk empfohlene Schulungsunterlagen.

DIGITAL MARKETING INSTITUTE

Als deutschlandweit erster Education Partner des
weltweit agierenden Digital Marketing Institute

in Dublin bietet Innen medienreich Computer-
trainings praxiserprobte Schulungsprogramme
mit folgenden Abschliissen: Professional Diploma
in Digital Marketing, Search Marketing, Social
Media Marketing, Mobile Marketing.

Das Digital Marketing Institute entwickelt und
pflegt die Trainings zusammen mit einem Fachbei-
rat aus BranchengréBen wie Google, Facebook,
Twitter, Microsoft, PayPal etc., um die Aktualitat
und Relevanz der Inhalte zu gewahrleisten.

In Zusammenarbeit mit:

U

Mehr Informationen erhalten Sie unter:
http://dmi-diploma.medienreich.de/

10

Wir beraten Sie gerne unter 0800 - 5550116 (kostenfreie Beratungshotline)



yyDer Kurs hat fUr mich als
Mediengestalterin die richtigen
Schwerpunkte gesetzt, sodass
ich meinen taglichen Workflow
optimieren konnte &

AUTHORIZED
Al
i Training Center

Bundesverwaltungsamt
Adobe Photoshop

»Der Dozent war sehr kompetent und
ist auf alle Fragen und Probleme der
Teilnehmer sehr gut eingegangen.”

Foto: Andres Rodriguez@fotolia.com

T-Systems International
Adobe Acrobat Formulare und
Interaktivitat

»Der Unterrichtsstoff wurde mit
alternativen Lernmethoden gut auf-
gelockert. Die Wiederholungsphasen

zu Beginn der Unterrichtstage haben
viel gebracht.”

phenometex GmbH
Adobe AfterEffects

»Der Trainer verfligt (ber einen sehr
guten Background von Erfahrung
und Wissen und setzt dies auch bei
schwierig zu I6senden Anforderun-
gen ein und zeigt Alternativen.”
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AUTHORIZED
ﬂ Training Center
Adobe InDesign

GRUNDLAGEN - AUFBAU - FORTSCHRITT

3 Tage Spezial-Intensiv-Training

In diesem Training zu Adobe InDesign lernen Sie die
vielfaltigen Einsatzmdglichkeiten und Werkzeuge fiir
professionelles Layouten kennen.

TRAININGSINHALTE

Grundlagen (1. Tag)

> Benutzeroberflache, Navigation, Werkzeuge und Paletten

> Voreinstellungen, géngige Tastenkdirzel

> Menii- und Befehlsstruktur

> Seiten- und Dokumentenaufbau

> Arbeiten mit Layoutrahmen, Text- und Bildrahmen

> Arbeiten mit Sonderfarben und dokumentiibergreifendes
Arbeiten mit Farben

> Textbearbeitung, Absatz- und Zeichenformatierung

> Arbeiten mit Absatz- und Zeichenformaten — Grundlagen

) Zeichen-, Absatz- und Rahmenattribute

> Arbeiten mit Musterseiten Grundlagen

Aufbau (2. Tag)

> Grafiken importieren, Verknipfungen erstellen
> Adobe Bridge

> Grafik- und Vektorbearbeitung

> Objektformate

> Beschneidungspfade und Alphakanéle

> UmflieBenfunktion

> Arbeiten mit Absatz- und Zeichenformaten Fortschritt
> Tabellenfunktion

> Tabellenformate und Excel-Import

> Transparenzen und Transparenzreduzierung

> Arbeiten mit Musterseiten Fortschritt

> PDF-Export aus InDesign

Fortschritt (3. Tag)

> Inhaltsverzeichnis und Indexverknlpfungen

> Verknlpfte Inhalte

> Kurze Vorstellung des Colormanagements in
der Creative Suite

> 2-farbige Dokumente, Druckfarbenmanager

> Buchfunktion

> Kurze Vorstellung von Cross-Media-Publishing

> Hyperlinks und Schaltflachen

> Kurze Vorstellung der neuesten Programmfunktionen:
¢ Neuerungen Benutzeroberflaiche und Bedienfelder
e Alternatives Layout
e |iquid Layout
e Formularfelder
* Formatzuordnungen in verknlipftem Text

> Praktische Tipps & Tricks

VORAUSSETZUNGEN

Grundlagen:
> Allgemeine PC- oder Mac-Kenntnisse
> Grafik- und Bildbearbeitungskenntnisse

Aufbau und Fortschritt:
> Jeweils die Inhalte der vorangegangenen Trainingseinheit

AUTHORIZED
Training Center

Adobe Photoshop
GRUNDLAGEN — AUFBAU - FORTSCHRITT

3 Tage Spezial-Intensiv-Training

Das Photoshop-Training von erfahrenen Bild-
bearbeitungsprofis bringt lhnen das Wissen, um
die volle Leistungsfahigkeit von Adobe Photoshop
fur Ihre Zwecke nutzen zu kénnen.

TRAININGSINHALTE

Grundlagen (1. Tag)

> Einfihrung in die Bildbearbeitung

> Benutzeroberflache

> Werkzeugpalette, Mentileiste und Fenster
> Dateiformate, DateigroBe und Auflésung
> Datenimport und -export, Smart-Objects
> Auswahlwerkzeuge

> Textwerkzeuge und Texteffekte

> Retuschewerkzeuge

> Protokollfunktionen und Aktionen

Aufbau (2. Tag)

> Farbmodi (RGB, CMYK, Graustufen etc.) und Farbtiefe
> Farbseparation und Vierfarbmodus

> Alphakanale und Farbkanéle

> Tonwertkorrektur, Gradationskurve und Histogramm

> Einstellungsebenen

> Farbkorrekturen, Farben ersetzen

> Bildretusche, Bildstérungen entfernen

> Transparenzen

Fortschritt (3. Tag)
> Ebenenfunktionen, -verwaltung, -effekte
> Ebenenmasken
> Arbeiten mit Pfaden und Formebenen
> Maskieren von Bildelementen
> Freistellen auf verschiedene Arten
> Bildmontage
> Arbeiten mit Filtern
> Stapelverarbeitung
> Bilder fir das Web und GIF-Animationen
> Kurze Vorstellung der neuesten Programmfunktionen:
e Neuerungen Benutzeroberflache und Bedienfelder
* Neues Freistellungswerkzeug
e Hauttonabhéngige Auswahl und Maskierung
e Videobearbeitung (Photoshop Extended)
¢ 3D (Photoshop Extended)
® Weichzeichnungsgalerie
e Beleuchtungseffekte
> Praktische Tipps & Tricks

VORAUSSETZUNGEN

Grundlagen:
> Allgemeine PC- oder Mac-Kenntnisse

Aufbau und Fortschritt:
> Jeweils die Inhalte der vorangegangenen Trainingseinheit
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Alle Trainings bieten wir lhnen auch als individuelle Inhouse und Firmen Trainings an.



Termine/Preise entnehmen Sie bitte der
beigefiigten Preis- und Terminibersicht.

Trainingszeiten:
Jeweils von 09:30 — 17:00 Uhr
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AUTHORIZED
Training Center

Adobe lllustrator

GRUNDLAGEN - AUFBAU - FORTSCHRITT

3 Tage Spezial-Intensiv-Training

Im Training werden Ihnen die grundlegenden
Techniken und Funktionen vermittelt, um Adobe
lllustrator professionell einsetzen zu kénnen.

TRAININGSINHALTE

Grundlagen (1. Tag)

> Einfihrung in Arbeitsumgebung und Benutzeroberflache

> Das passende Start-Profil wahlen

> Zeichenflachen definieren

> Tastaturkirzel und Ansichten

> Grundformen und Vektoren zeichnen

> Auswahlwerkzeuge

> Einfarbemethoden

> Texte und Typografie

> Datei speichern

> Import und Export von Daten

> Komplexe Formen mit Pathfinder und
Formerstellungswerkzeug konstruieren

Aufbau (2. Tag)

> Hilfen im Programm wie Hilfslinienarten, Raster
und Ebenen

> Formen transformieren (drehen, spiegeln u.&.)

> Konturen

> Aussehenbedienfeld

> Flllungen, Verldufe und Pipette

> Textwerkzeuge

> Punkttext, Flachentext, Text auf Pfad, Formtext

> Absatz- und Zeichen-Bedienfeld

> Schrifteffekte einsetzen

> Formate erstellen und verwenden

Fortschritt (3. Tag)

> Stifte und Pinsel

> Masken und Transparenzen

> Arbeiten mit Symbolen

> Diagramme erstellen

> Effektfilter und 3D-Effekte

> lllustrationen mit dem Gitterwerkzeug
> Perspektivgitter-Werkzeug

> Automatisches Vektorisieren

> Umgang mit Besténden

> PDF-Erstellung

> Kurze Vorstellung der neuesten Programmfunktionen
> Praktische Tipps & Tricks

VORAUSSETZUNGEN

Grundlagen:
> Allgemeine PC- oder Mac-Kenntnisse
> Grafik- und Bildbearbeitungvskenntnisse

Aufbau und Fortschritt:
> Jeweils die Inhalte der vorangegangenen Trainingseinheit

AUTHORIZED
Training Center

Print-/Layout mit InDesign & Photoshop

GRUNDLAGEN — AUFBAU — FORTSCHRITT

5 Tage Spezial-Intensiv-Training

In diesem praxisorientierten Training lernen Sie,
die Funktionen von Adobe InDesign und Adobe
Photoshop optimal zu nutzen und einzusetzen.

TRAININGSINHALTE

Photoshop Grundlagen (1. Tag)

> Werkzeuge und Paletten

> Auswahlen, Retusche, Farb- und Kontrastkorrekturen
> Ebenen, Effekte, Kanale

> Pfaderstellung

Photoshop Aufbaukurs (2. Tag)

> Ebenenmasken, Bildmontage

> Text, Effekte, Filter

> Farbsysteme, Auflésung, Speicherformate

InDesign Grundlagen (3. Tag)

> Benutzeroberflache, Navigation

> Werkzeuge und Paletten

> Seiten- und Dokumentenaufbau

> Layoutrahmen, Text- und Bildrahmen
> Textbearbeitung, Typografie

InDesign Aufbaukurs (4. Tag)

> Musterseiten, Absatz- und Zeichenformate
> Grafikbearbeitung, Freistellpfade

> Vektorbearbeitung, Pathfinder

> Tabellen, Farben und Verlaufe

Photoshop und InDesign Fortschritt (5. Tag)

> Datenaustausch, Bild- und Textmontage

> Inhaltsverzeichnis und Indexverknlpfungen

> Erstellen von Printprodukten anhand von
Beispiellibungen

> Workflow und Druckvorbereitung, Transparenzen

> Praktische Tipps & Tricks

VORAUSSETZUNGEN

Grundlagen:
> Allgemeine PC- oder Mac-Kenntnisse
> Grundlegende Gestaltungskenntnisse sind von Vorteil

Aufbau und Fortschritt:
> Jeweils die Inhalte der vorangegangenen Trainingseinheit
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Uber 1.000 weitere Trainingsthemen finden Sie auf www.medienreich.de!
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AUTHORIZED
Training Center

Adobe After Effects

GRUNDLAGEN - AUFBAU - FORTSCHRITT

3 Tage Spezial-Intensiv-Training

Das Training ist fiir Teilnehmer konzipiert, die die
grundlegenden Techniken von Adobe After Effects
kennenlernen und effektiv nutzen méchten.

TRAININGSINHALTE

Grundlagen (1. Tag)

> Begriffe und Standards

> Formatdefinitionen

> Projektplanung und -organisation

> Importieren und Verwalten von Rohdaten
> Layout in After Effects

> Komposition und Zeitleiste

> Ebenen organisieren und bearbeiten

> Einfache Animationen erstellen

> Animationsvorgaben verwenden und anpassen
> Keyframe-Grundlagen

> Keyframe-Interpolation

> Kompression und Codecs

> Film rendern und Rendereinstellungen

Aufbau (2. Tag)

> Masken, Matten und Alphakanéle
> Masken-Interpolationen

> Formebenen

> Malen und Retuschieren

> Flllmethoden

> Arbeiten mit dem Roto-Pinsel

> Audiofunktionen und -bearbeitung
> Kamerawerkzeuge und -optionen

> Zeitlupenfunktionen

> Textanimationen

> Arbeiten mit Textanimator-Gruppen
> Animationen mit den Puppenwerkzeugen

Fortschritt (3. Tag)

> Motion-Tracking

> Mocha

> Farbkorrekturen und Farbmanagement
> Color-Finesse

> 3D in After Effects

> Arbeiten mit Expressions

> Die Sprache der Expressions

> Workflow mit Photoshop und lllustrator
> Zusammenarbeit mit Premiere Pro und Flash
> Praktische Tipps & Tricks

VORAUSSETZUNGEN

Grundlagen:
> Allgemeine PC- oder Mac-Kenntnisse
> Grafik- und Bildbearbeitungvskenntnisse sind vorteilhaft

Aufbau und Fortschritt:
> Jeweils die Inhalte der vorangegangenen Trainingseinheit

AUTHORIZED
Training Center

Adobe FrameMaker

GRUNDLAGEN - AUFBAU - FORTSCHRITT

3 Tage Spezial-Intensiv-Training

In diesem Training lernen Sie, Publikationen mit
Adobe FrameMaker zu erstellen und mithilfe
verschiedener Medien zu prasentieren.

TRAININGSINHALTE

Grundlagen (1. Tag)

> Textbearbeitung und Formatieren
> Absatz- und Zeichenformate

> Suchen und Ersetzen von Text und Formaten
> FrameMaker-Vorlagen erstellen

> Textimport (Word)

> FuBnoten definieren

> Programmvoreinstellungen

> Automatische Nummerierung

> Lebende Kolumnentitel

> Automatisch generierte Inhalte

> Farbe

> Bilder in verankerten Rahmen

> Bildlegenden und Initialen

> FlieBtext um Bilder

Aufbau (2. Tag)

> Musterseiten anlegen, verwalten und &ndern

> Inhalte zu Musterseiten hinzufiigen

> Systemvariablen fir Seitenzahlen

> Variablen fir laufende Kopf- und FuBzeilen und
> wiederkehrende Dokumentinformationen

> Arbeiten mit Referenzseiten

> Anlegen benutzerdefinierter Seiten

> Erstellen von Tabellen

> Tabellenimport (Excel)

> Tabellenformate, Zeilenformate und Tabellen-Variablen
> Formatieren von Text in Tabellenzellen

> Bucherstellung

> Erstellen von Dokumentvorlagen

Fortschritt (3. Tag)

> Erstellen und Formatieren eines Inhaltsverzeichnisses

> Anderung der TOC Referenzseite

> Indexerstellung

> Andern der Indexreferenzseite

> Buchdateien anlegen und verwalten

> Neuformatierung Uber ein ganzes Buch hinweg

> Vorlagenerstellen fir Dokumente, Inhaltsverzeichnisse
und Indizes

> Bedingte Dokumente

> Querverweise und Texteinschiibe

> Tipps & Tricks
VORAUSSETZUNGEN
Grundlagen:

> Allgemeine PC- oder Mac-Kenntnisse
> Grafik- und Bildbearbeitungskenntnisse sind vorteilhaft

Aufbau und Fortschritt:
> Jeweils die Inhalte der vorangegangenen Trainingseinheit
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Termine/Preise entnehmen Sie bitte der Trainingszeiten: &@E’diE’ﬂfE’lCh

beigefiigten Preis- und Terminibersicht. Jeweils von 09:30 — 17:00 Uhr
AUTHORIZED AUTHORIZED
@ Training Center Training Center
Adobe LiveCycle Designer Adobe Premiere

KOMPAKT GRUNDLAGEN - AUFBAU - FORTSCHRITT W
=
2 Tage Kompakt-Intensiv-Training 3 Tage Spezial-Intensiv-Training =
7
In diesem Training lernen Sie, mit dem Adobe Erlernen Sie in diesem Seminar den sicheren w
LiveCycle Designer interaktive Formulare und Umgang mit Adobe Premiere fiir das professionelle g
personalisierte Dokumente zu erstellen. Schneiden und Nachbearbeiten von digitalen Videos. 2

TRAININGSINHALTE TRAININGSINHALTE

) Einfiihrung in die Benutzeroberflache Grundlagen (1. Tag)

> Programmeinstellungen > Projektausrichtung und Formatdefinition

> Arbeitsbereich von LiveCycle Designer > Moglichkeiten von Adobe Premiere

> Formulare und Formularentwiirfe > Programmoberflache

> Formularvorlagen erstellen und bearbeiten > Text- und Objektvorlagen

> Mit Objekten arbeiten > Projekt-, Schnitt- und Monitorfenster

> Datenquellen > Footage-Analyse

> Barrierefreie Formulare

> Dokumentensicherheit und digitale Signaturen Aufbau (2. Tag)

> Dynamische Formular- und Dokumentfragmente > Montage von Clips im Schnittfenster

> E-Mail- und serverbasierte Formulare > Uberblendungen und Effekte

> XML-Daten und Schemazuordnungen > Titelgenerator

> Skripterstellung > Importieren von Bildern, Audiodateien und Verzeichnissen
> Musterformulare und Bausteine > Schnellere Bedienung durch Befehle oder Tasten
> Praktische Tipps & Tricks > Video-Retusche und -Filter

> Bild- und Farbkorrektur

> Arbeiten mit Blenden
VORAUSSETZUNGEN > Import- und Exportfunktionen

Fortschritt (3. Tag)

> DV-Bearbeitung

> Kombination mit anderen Adobe-Programmen

> Sounderstellung und -bearbeitung

> Animierte Videoclips

> Kurze Vorstellung der neuesten Programmfunktionen:
e Neuerungen der Benutzeroberflache und Bedienfelder
e Dynamischer Videoschnitt
e Stabilisierung verwackelter Aufnahmen
e Einstellungsebenen
e Optimierte Dreiwege-Farbkorrektur

> Praktische Tipps & Tricks

VORAUSSETZUNGEN

Grundlagen:
> Allgemeine PC- oder Mac-Kenntnisse
> Grafik- und Bildbearbeitungskenntnisse sind vorteilhaft

> Grundkenntnisse in Adobe Acrobat

Aufbau und Fortschritt:
> Jeweils die Inhalte der vorangegangenen Trainingseinheit

Uber 1.000 weitere Trainingsthemen finden Sie auf www.medienreich.de! 15
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AUTHORIZED
Training Center

Adobe Dreamweaver

GRUNDLAGEN - AUFBAU - FORTSCHRITT

3 Tage Spezial-Intensiv-Training

Das anschauliche Seminar vermittelt Ihnen die
Grundlagen fiir den professionellen Umgang
mit Adobe Dreamweaver.

TRAININGSINHALTE

Grundlagen (1. Tag)

> Kurze Einfihrung in HTML

> Funktionen von Dreamweaver

> Einfiihrung in die Benutzeroberflache

> Einflhrung in das Site-Management

> Bearbeitung und Formatierung von Texten
> Integration von Bild und Text

) Tabellen erstellen und editieren

Aufbau (2. Tag)

> Einfiigen von Ebenen

> Einfligen von Multimedia-Objekten
> Datenaustauschformate

> Arbeiten mit Frames

> Generieren von JavaScript-Codes
> Einflhrung von CSS

> Bibliotheken

Fortschritt (3. Tag)
> Fortgeschrittenes Site-Management
> Fehlererkennung und -behebung
> Optimierung von Ladezeiten
> Browserspezifische Besonderheiten
> Flash-Navigationshilfen
> Neueste Programmfunktionen:
* Neuerungen Benutzeroberflaiche und Bedienfelder
* jQuery Mobile
e Fluid Grid Layouts
e Adobe PhoneGap
e CSS3-Transitions
> Praktische Tipps & Tricks

VORAUSSETZUNGEN

Grundlagen:
> Allgemeine PC- oder Mac-Kenntnisse
> Grafik- und Bildbearbeitungskenntnisse sind vorteilhaft

Aufbau und Fortschritt:
> Jeweils die Inhalte der vorangegangenen Trainingseinheit

AUTHORIZED
Training Center

Adobe Captivate

KOMPAKT

2 Tage Kompakt-Intensiv-Training

Dieses Training erleichtert Ihnen den professionellen
Umgang mit dem E-Learning-Werkzeug Adobe
Captivate.

TRAININGSINHALTE

> Benutzeroberflache und Navigation

> Bibliothek, Symbole und Instanzen

> Aufzeichnen und Bearbeiten einer Simulation

> Szenario-basierte Simulationen

> Bilder und Animationen hinzufligen und bearbeiten

> Arbeiten mit der Zeitleiste

> Mausbewegungen aufzeichnen und bearbeiten

> Textbeschriftung und Textanimation

> Audioeffekte und Video

> Integration von Fragen/Antworten

> Folien und Hintergrund-Objekte

> Projekte in verschiedenen Ausgabeformaten
veroffentlichen

VORAUSSETZUNGEN

> Allgemeine PC- oder Mac-Kenntnisse

16
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S4P solutions for partners ag
CorelDRAW

»Der Trainer ist voll und ganz auf die
Trainingswiinsche eingegangen, so-
dass es mir méglich ist, bereits nach

2 Tagen Training unseren Anforde-
rungen in Corel gerecht zu werden.
Vielen Dank!*

sy Die sehr gut autbereiteten
Schulungsinhalte haben
mir in meinem Beruf
als Grafiker enorm
weitergeholfen £

Foto: Yuri Arcurs@fotolia.com

Deutsche Rentenversicherung Stadtwerke Bielefeld
Mitteldeutschland QuarkXPress
Umstieg von QuarkXPress auf
InDesign

,Das war eine der besten Schu-
,Da es sich um eine Inhouse-Schu- lungen, die ich bis jetzt hatte! Freue
lung gehandelt hat, konnte die Trai- mich auf die nédchste bei dem
nerin auf die individuellen Wiinsche Trainer!”
und Anforderungen eingehen. Die
Art und Weise des Trainings sowie
die Trainerin haben mir sehr gut
gefallen.”

DTP & MULTIMEDIA - SONSTIGE
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CorelDRAW

GRUNDLAGEN - AUFBAU - FORTSCHRITT

3 Tage Spezial-Intensiv-Training

Im Training lernen Sie die Techniken und Funktio-
nalitaten kennen, die Sie fir lhre effektive Arbeit mit
der Grafikdesign-Software CorelDRAW bendtigen.

TRAININGSINHALTE

Grundlagen (1. Tag)

> Grundlagen der Bedienung

> Einflhrung in die Benutzeroberflache von CorelDRAW
> Zeichenwerkzeuge

> Import und Export von Grafiken

> Grundlagen der Objektbearbeitung

> Textbearbeitung

> Seitenlayouts

> Verwendung der weiteren Werkzeuge

> Definition von Farben

Aufbau (2. Tag)

> Uberlagern von Objekten und Gruppierungen
> Arbeiten mit Knoten und Linien

> Symbolbibliotheken, Cliparts

> Objekttypen

> Arbeiten mit Bitmaps

> Farbmanagement

> Farbgestaltung

> Farbverlaufe

Fortschritt (3. Tag)

> Effekte und 3D-Effekte

> Verwendung von Ebenen

> Grafiken vorbereiten fur das Web

> Grafiken vorbereiten fur den Druck

> Drucker- und belichtungsspezifische Ausgabeoptionen
> Besondere PostScript-Optionen

> Neueste Programmfunktionen

> Praktische Tipps & Tricks

VORAUSSETZUNGEN

Grundlagen:
> Aligemeine PC- oder Mac-Kenntnisse
> Grafik- und Bildbearbeitungskenntnisse sind vorteilhaft

Aufbau und Fortschritt:
> Jeweils die Inhalte der vorangegangenen Trainingseinheit

QuarkXPress

GRUNDLAGEN - AUFBAU - FORTSCHRITT

3 Tage Spezial-Intensiv-Training

Im Training lernen Sie Tipps und Tricks fiir die
effektive und kreative Arbeitsweise mit dem
beliebten Layoutprogramm QuarkXPress.

TRAININGSINHALTE

Grundlagen (1. Tag)

> Arbeitsoberflache und Einstieg

> Verwendung der Werkzeuge

> Definition von Farben

> Layouts strukturieren und Musterseiten erstellen
> Textrahmen und deren typografische Gestaltung
> Bildrahmen und grafische Elemente

> Fremddaten importieren

> Arbeiten mit Ebenen

Aufbau (2. Tag)

> Textverwaltung, Textimport, Platzierung im Rahmen
> Zeichen- und Absatzattribute

> Tabulatoren

> Grundlinienraster

> Arbeiten mit Mustervorlagen und Paginierung

> Arbeiten mit Stilvorlagen

> Bildimport, Skalierung, Bildplatzierung

> Freistellen und UmflieBen von Bildern

Fortschritt (3. Tag)

> Funktionalitat der Bibliothek

> Tabellensatz und Tabellen einrichten

> Listenerstellung und Indexerstellung

> Druckoptionen, Separation und Uberfiillen
> PDF-Erstellung mit Acrobat Distiller

> Neue Funktionen, Tipps & Tricks

VORAUSSETZUNGEN

Grundlagen:
> Allgemeine PC- oder Mac-Kenntnisse

Aufbau und Fortschritt:
> Jeweils die Inhalte der vorangegangenen Trainingseinheit

18

Alle Trainings bieten wir lhnen auch als individuelle Inhouse und Firmen Trainings an.



Termine/Preise entnehmen Sie bitte der Trainingszeiten: Q@Qdi@ﬂf@ifh

beigefiigten Preis- und Terminiibersicht. Jeweils von 09:30 — 17:00 Uhr COMPUTERTRAININGS
Final Cut Pro CorelDRAW Technical Suite
KOMPAKT KOMPAKT
3 Tage Kompakt-Intensiv-Training 5 Tage Kompakt-Intensiv-Training
In dieser Schulung erlernen Sie die vielfaltigen Der Kurs ist ideal fir Profi-Anwender von Corel
Funktionen des Video- und Filmschnittprogramms DESIGNER, Corel PHOTO-PAINT, Corel
Final Cut Pro. PowerTRACE, Right Hemisphere Deep Exploration

und Corel CAPTURE.

TRAININGSINHALTE TRAININGSINHALTE
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> Grundlagen Filmschnitt > Méglichkeiten und Fahigkeiten der Corel Designer
> Projektorganisation und Workflow Technical Suite

> Programmoberflache > Aligemeiner Workflow

> Formate und Auflésungen > Zeichenwerkzeuge

> Roh- und Feinschnitt > BemaBungswerkzeuge

> Timeline > Szenerien technischer lllustration

> Trimmen > Vorlagen

> Bildbearbeitung > Schriften

> Tonbearbeitung > Bildretusche und Bildoptimierung

> Uberblendungen, Effekte und Filter > Vektorisierung von Bitmaps

> Compositing > Import von Dateien verschiedenster Herkunft
> Titel und Text > Import und Umwandlung von 3D-Vorlagen

> Import- und Exportfunktionen > Grundlagen der Objektbearbeitung

> Ausgabe > Screenshots mit CAPTURE

> Uberblick tiber weitere Tools des Studio-Pakets > Online-Zusammenarbeit mit ConceptShare

> Praktische Tipps & Tricks > Geschutzte PDF-Ausgabe

> Praktische Tipps & Tricks

VORAUSSETZUNGEN VORAUSSETZUNGEN

Grundlagen:
> Aligemeine Mac-Kenntnisse > Allgemeine PC- oder Mac-Kenntnisse

> Grundlegende Gestaltungskenntnisse sind von Vorteil

Aufbau und Fortschritt:
> Jeweils die Inhalte der vorangegangenen Trainingseinheit

Uber 1.000 weitere Trainingsthemen finden Sie auf www.medienreich.de! 19
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Logo-Design mit CoreIDRAW

KOMPAKT

2 Tage Kompakt-Intensiv-Training

Die Schulung Logo-Design mit CoreIDRAW erstellen
vermittelt die wichtigsten Fahigkeiten, um selbst
professionelle und einpragsame Logos und Bild-

marken erstellen und anpassen zu kénnen.

TRAININGSINHALTE

> Gestaltungsgrundlagen

> Elemente

> Proportionen

> Farben

> Variationen

> Symbole/Symbolbibliotheken
> Kinstlerische Medien

> Verlaufe/Maschenfillung

> Boolesche Operatoren

> Objektstile

> Uberblendung

> Schriftarten

> Pfadtext

> Schrift in Kurven konvertieren
> Fonts bearbeiten

> Wort-/Bildmarke

> 3D/Perspektive

> Extrudieren

> Lichter

> Musterfullung

> Postscript-Fullung

> Anpassungen in PhotoPaint
> Praktische Tipps & Tricks

VORAUSSETZUNGEN

> Grundlagen von CorelDRAW

Farbmanagement

KOMPAKT

1 Tag Kompakt-Intensiv-Training

Das Seminar analysiert den Workflow bei der
Erstellung von farbigem Bildmaterial im Team
und zeigt Farbmanagement-Methoden zwischen
AugenmaB und Spektralanalyse.

TRAININGSINHALTE

> Grundlagen der Farblehre

> Bedeutung des Farbmanagements

> Farbrdume

> Ubergénge zwischen den Farbraumen

> Darstellung von Farbe auf verschiedenen Systemen
> Methoden zur Referenzierung

> Kalibrierung

> Grundlagen von Farbmanagement-Systemen
> Druckerprofile

> Profilgenerierung

> Optimierung der Arbeitsablaufe

> Praktische Tipps & Tricks

VORAUSSETZUNGEN

> Grundkenntnisse Desktop-Publishing

20
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yy UD einfache Logos oder
komplexe Animationen:
Durch das Training kann ich
die Software in meinem Job
als 3D-Spezialist effektiver

einsetzen bk

/\ AUTODESK

Authorized Training Center

Foto: Rido@fotolia.com

MOVE YA! Lifestyle Kontor GmbH
3D Studio Max

»Der Trainer war ein sehr kompe-
tenter und sympathischer Dozent,
der es verstanden hat, in der Kirze

der Zeit einen guten Einstieg in das
Thema zu vermitteln. Auf Fragen ist
er sehr gut eingegangen, bis die ent-
standenen Probleme beseitigt und
gelést waren. Eine rundum gelungene
Schulung, die ich jederzeit weiter-
empfehlen werde.”

Stroer Infoscreen
CINEMA 4D

,In kurzer Zeit wurde viel Wissen
sehr effektiv vermittelt — dazu hat das
Seminar auch noch SpaBB gemacht,
da der Dozent nicht nur kompetent
und aufmerksam, sondern auch noch
sehr nett war. Auf Fragen und auf
Gegebenheiten der Arbeitssituation
wurde ebenfalls geduldigst einge-
gangen. GroBe Empfehlung!“

Medienzentrum
der Universitatsklinik Heidelberg
CINEMA 4D

»~Kurzfassung: Klasse Schulung. Im
Detail: Die Zusammenarbeit mit dem
Dozenten war sehr angenehm. Hier
wurde kein Programm abgespult,
vielmehr hatte der Trainer ein zwar
klar gegliedertes Konzept vorberei-
tet, ging jedoch wéhrend der Schu-
lung sofort auf Fragen, Vorschldge
etc. ein, sodass ein lebhafter, effek-
tiver Unterricht stattfinden konnte.“

3D-VISUALISIERUNG - CAD
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{\ AUTODESK

“ Autodesk AutoGAD —
Grundlagen — Aufbau

KOMPAKT

3 Tage Kompakt-Intensiv-Training

Das Seminar vermittelt das wesentliche Know-how
fur die professionelle Anwendung von Autodesk
AutoCAD zur Erstellung von 2D- und
3D-Zeichnungen.

TRAININGSINHALTE

Grundregeln der Programmbedienung:
> Historie

> Funktionsweise

> Abgrenzung

Zeichenraum:

> Programmaufbau

> Zeichnungen neu anlegen, laden und speichern
> Hilfen fur das exakte Zeichnen

> Koordinatensystem(e)

> Objekttypen und -eigenschaften

> Orientierung

Befehle und Systemvariablen:
> Befehlsaufruf, -optionen und -defaultwerte
> Verhalten von Programm und Befehlen steuern

Objekte und Koordinaten:

> Objekte zeichnen

> Objekte &ndern

> Absolute und relative Koordinaten

> Objektféange und Zeichenhilfen

> Maus und Tastatur im Zusammenspiel
> Hilfe fur die Objektwahl

> Text eingeben und &ndern

> Schraffieren und Fléachen fullen

> Layertechnik und Objekteigenschaften
> Mit Blocken arbeiten

> BemaBungen erstellen und &ndern

Strukturelemente:

> Verzeichnisse

> Dateien

> Blocke

> Layer

> Stile

> Beschriftungseigenschaft

Plotten:

> MaBstébe, Plotten, Modell- und Papierbereich
> Messen, Abfragen und Hilfsfunktionen

> Praktische Tipps & Tricks

VORAUSSETZUNGEN

> Allgemeine PC-Kenntnisse und grundlegende
geometrische/zeichnerische Kenntnisse

{\ AUTODESK

e Autodesk Inventor -
Grundlagen - Aufbau

KOMPAKT

4 Tage Kompakt-Intensiv-Training

Das Seminar macht Sie rundum fit fiir die Anwen-
dung der 3D-CAD-Software Autodesk Inventor.

TRAININGSINHALTE

> EinfUhrung in die Benutzeroberflache
> 2D-Skizzenerstellung

> Skizzenelemente

> Abhéngigkeiten

> Skizzen-Methodik

> Grundlagen der 3D-Teilmodellierung
> Arbeiten mit Features

> Mustererstellung

> SchweiBkonstruktionen

> Normgerechte Zeichnungsableitung
> Schnittansichten

> BemaBungen

> Detailansichten

> Beschriftungen

> Erstellen/Verwenden von Baugruppen
> Verknlpfungen in Baugruppen

> Analysetools

> Messwerkzeuge

> Toolbox

> Praktische Tipps & Tricks

VORAUSSETZUNGEN

> Allgemeine PC-Kenntnisse und Grafik- und
3D-Kenntnisse sind von Vorteil

22
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Termine/Preise entnehmen Sie bitte der Trainingszeiten:
beigefiigten Preis- und Terminibersicht. Jeweils von 09:30 — 17:00 Uhr

{\ AUTODESK

== Autodesk 3ds Max CINEMA 4D

GRUNDLAGEN - AUFBAU - FORTSCHRITT KOMPAKT

a

<t

(%]

3 Tage Spezial-Intensiv-Training 3 Tage Kompakt-Intensiv-Training ‘_,'J
=

Lernen Sie in diesem Training die Einsatzmdglich- Dieses Training fiir die 3D-Grafik-Software von E
keiten von Autodesk 3ds Max kennen, vom MAXON, CINEMA 4D, versetzt Sie in die Lage, alle s
Modellieren Uber Lichtsetzung und Kamera- anfallenden Standardaufgaben im 3D-Bereich =
perspektiven bis zur Animation. professionell zu I6sen. g

(2]

-

Q

(3]

TRAININGSINHALTE TRAININGSINHALTE

Grundlagen (1. Tag) > CINEMA 4D-Workflow
> Programmoberflache > 2D- und 3D-Unterschiede
> Grundkorper erstellen > Erstellen und Verstehen von Objekten
> Orientieren im Raum > Hierarchische Beziehungen
> Ansichtsfenstertechnik > Arbeiten mit Splines
> Schieben, Drehen, Skalieren von Objekten > Polygonale Modelling-Werkzeuge

> 3D-Objekte: Punkte, Kanten und Polygone
Aufbau (2. Tag) > Extrudierung
> Boolesche Operatoren > HyperNURBS )
> Figuren und Verformungen > Deformierungswerkzeuge zum gezielten Andern
> Erstellung von 3D-Figuren von Objekten
> Extrusionsobjekte und -verformungen > Material und Texturierung
> Szenenelemente, Szenenbeleuchtung > Beleuchtung
> Lichtquellentypen, Lichtparameter > Arbeiten mit Licht und Schatten im 3D-Raum
> Kamera > Keyframes und Animation

> Arbeiten mit der Zeitleiste
Fortschritt (3. Tag) > Kamera
) Materialien > Bewegung und Kontrolle
> Materialienzuweisung und -editor > Rendern )
> Mapping > 3D-Animation o
> Animation und Rendering > Zusammenarbeit mit Adobe AfterEffects
> Einfaches Keyframing > Einflihrung in MoGraph
» Pfadanimation > Texturierung mit BodyPaint
> Animation von Objektparametern > Rundum ,Dynamics®
> Neueste Programmfunktionen > Kurze XPresso-Einfuhrung
> Praktische Tipps & Tricks > Partikelwelten

> Neueste Programmfunktionen

VORAUSSETZUNGEN VORAUSSETZUNGEN

Grundlaggn: . Grundlagen:

> Aligemeine PC- oder Mac-Kenntnisse > Allgemeine PC- oder Mac-Kenntnisse

> Grafik- und Bildbearbeitungskenntnisse sind vorteilhaft > Grafik- und Bildbearbeitungskenntnisse

Aufbau und Fortschritt: o o Aufbau und Fortschritt:

> Jeweils die Inhalte der vorangegangenen Trainingseinheit > Jeweils die Inhalte der vorangegangenen Trainingseinheit

Uber 1.000 weitere Trainingsthemen finden Sie auf www.medienreich.de! 23



www.medienreich.com
E-Mail: info@medienreich.com

Hotline Deutschland 0800-5550116 kostenfrei
Hotline Osterreich 0820-400120 € 0,12/Min.

=)
<<
S
I
[
=
=)
o
—
=
—
<<
>
=
=
a
™

3D-Visualisierungen mit CINEMA 4D
und After Effects

GRUNDLAGEN - AUFBAU - FORTSCHRITT

5 Tage Spezial-Intensiv-Training

Das Seminar zu MAXON CINEMA 4D und Adobe
After Effects richtet sich an alle, die ihre 3D-Umset-
zungen mit Visual Effects durch Adobe After Effects

aufwerten und vervollstandigen wollen.

TRAININGSINHALTE

CINEMA 4D Grundlagen

> Arbeitsablaufe und Benutzeroberflache

> Schieben, Drehen, Skalieren von Objekten
> Einfaches Modelling

> Grundkorper erstellen

> Modellieren mit HyperNURBS

> Materialmanager

CINEMA 4D Aufbau

> Kamera setzen, Perspektive und Parameter

> Beleuchtung

> Kamerafahrt und Objektanimation

> Animationswerkzeuge, Animationsgrundlagen
> Animieren mit F-Curves und XPresso

> Rendering

> Datenformate flir den Import und Export

AfterEffects Grundlagen

> Importieren und Bearbeiten von Dateien

> Bewegungssteuerung

> Arbeiten mit verschiedenen Ebenen

> Erstellen von Kompositionen und verschachtelten
> Kompositionen

> Arbeiten mit Keyframes

AfterEffects Aufbau

> Arbeiten mit Masken und Textwerkzeugen

> Audiobearbeitung, Arbeiten mit dem Diagrammeditor
> Zeitverzerrung

> Erstellen von visuellen Effekten

> Vektor-Zeichenwerkzeuge und Retusche

CINEMA 4D und AfterEffects Fortschritt
) Erstellen von 3D-Animationen

> Licht und Kamera, Farbkorrektur

> Render-Einstellungen

> Import- und Exportfunktionen

> Praktische Tipps & Tricks

VORAUSSETZUNGEN

> Allgemeine PC- oder Mac-Kenntnisse

Nemetschek Allplan
Grundlagen — Aufbau

KOMPAKT

4 Tage Kompakt-Intensiv-Training

Lernen Sie in unserer Nemetschek Allplan Schulung
alles Notwendige zur CAD-unterstiitzten Planung
von Gebauden fiir den Ingenieurbau kennen.

TRAININGSINHALTE

> EinfUhrung in die Benutzeroberflache

> Mentis

> Lernhilfen (z.B. Nutzung des Assistenten)

> Organisation von Projekten

> Arbeiten mit Symbolen

> Erstellung von 2D-Konstruktionen mit Text, BemaBung

> Moglichkeiten in der Modifikation von Stlitzen, Wanden
und Offnungen

> Bildschirminhalt in Allplan drucken

> Standardebenen

> Erzeugung von Rdumen und Beschriftung

> Wie gestalte ich Tiren, Fenster, Oberflachen?

> Geschosse

> Material bearbeiten

> Bauteilhdhe und Wandstarke bearbeiten

> Planausgabe

> Plotten und Sicherung der Allplan-Daten

> Praktische Tipps & Tricks

VORAUSSETZUNGEN

> PC-Grundlagen-Kenntnisse
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yyDank der Office-Schulungen
meistern wir den Buroalltag
effizienter und effektiver als
zuvor k&

BUROANWENDUNGEN — MICROSOFT OFFICE

Microsoft Partner

Silver Learning

Foto: Yuri Arcurs@fotolia.com

ExxonMobil Production Guhl Ikebana GmbH Handwerkskammer
Deutschland GmbH Excel Excel - Aufbau
Excel - Aufbau

»,Die Trainerin hat die Aufgaben sehr »,Gute Mischung aus ,Theorie* und »ES war gut, dass die Trainerin uns
gut vermittelt und die Teilnehmer praktischer Anwendung unter viele kleine Handgriffe und Tricks
immer wieder mit einbezogen, so- Berticksichtigung der Bedlrfnisse im tdglichen Umgang mit dem Pro-

dass die Probleme grundsétzlich der Teilnehmer.” gramm gezeigt hat und auch auf

gemeinsam geldst werden konnten.“ individuelle Fragen eingegangen ist.
Die GruppengréBe war sehr ange-
nehm, somit konnte man wirklich
jede Frage von der Trainerin beant-
wortet bekommen.“
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Microsoft Partner

ver Learning

Microsoft Excel -
Programmierung mit VBA

KOMPAKT

3 Tage Kompakt-Intensiv-Training

Der Kurs vermittelt fundiertes Know-how tiber
Makros und das Programmieren mit VBA fir
weitergehende und anspruchsvollere Lésungen
mit Microsoft Excel.

TRAININGSINHALTE

Einfache Makro-Programmierung

> Aufzeichnen und Anpassen von Makros
> Verwaltung von Makros

> Ausfiihrung von Makros

VBA-Entwicklungsumgebung

Einfiihrung in die Programmierung mit Visual Basic
fiir Anwendungen (VBA)

> Variablen und Konstanten

> Ein-/Ausgabe

> Strukturiertes Programmieren

> Unterprogramme und Parameter

> Kontrollstrukturen

Kurze Einfiihrung in die Objektorientierte
Programmierung
> Klassen, Objekte und Methoden

Automatisierung von Word mithilfe des
Word-0bjektmodells

> Klassen und Objekte von Excel-VBA

> Fernsteuern der Excel-Befehle

> Ereignisse der Excel-Objekte

Programmierung von benutzerdefinierten Dialogen
mit VBA

Weiterfiihrende Techniken

> Fehlersuche und Programmverfolgung
> 1/0O-Programmierung

> Registry-Zugriff

VORAUSSETZUNGEN

> Grundlagen und Aufbau von Excel
> Grundlagen und Aufbau von Windows-Anwendungen

Microsoft Partner

Silver Learning

Microsoft Excel

GRUNDLAGEN - AUFBAU - FORTSCHRITT
3 Tage Spezial-Intensiv-Training

Der Kurs vermittelt umfangreiche Grundkenntnisse
des am weitesten verbreiteten Tabellenkalkulations-
programms Microsoft Excel.

TRAININGSINHALTE

Grundlagen (1. Tag)

> Arbeitsoberflache

> Grundlagen der Arbeitsmappenverwaltung
> Formatierung von Zellen

> Bewegung im Tabellenblatt

> Tabellenstruktur

> Einfache Formeln

> Berechnung mit Funktionen und Namen

> Die Funktion SUMME/Mittelwert/Anzahl

Aufbau (2. Tag)

> Funktionsassistent verwenden

> Diagramme erstellen

> Druckbereich, Seitenansicht einstellen
> Vorlagen

> Grafiken einbinden

> Dateimanagement und Drucklayout

> Tabelleninhalte iberwachen

> Grundlagen der Datenbankfunktionen
> Mit Excel-Datenbanken arbeiten

> Sortieren und Filtern

> Teilergebnisse

Fortschritt (3. Tag)

> Datenanalyse

> Verweisfunktion

> Formelauswertung

> Kombinieren und konsolidieren
> Trendanalysen erstellen

> Excel-Solver benutzen

> Szenario-Manager benutzen

> Zielwertsuche

> Gultigkeitsregeln

> Matrizen

> Excel in Verbindung mit anderen Anwendungen
> Praktische Tipps & Tricks

VORAUSSETZUNGEN

Grundlagen:
> Allgemeine PC-Kenntnisse

Aufbau und Fortschritt:
> Jeweils die Inhalte der vorangegangenen Trainingseinheit
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Termine/Preise entnehmen Sie bitte der Trainingszeiten: @edienrelch

beigefiigten Preis- und Terminibersicht. Jeweils von 09:30 — 17:00 Uhr

Microsoft Partner Microsoft Partner

o Microsoft Project - Microsoft Office —

Update auf Version 2013

GRUNDLAGEN — AUFBAU - FORTSCHRITT GRUNDLAGEN — AUFBAU - FORTSCHRITT

3 Tage Spezial-Intensiv-Training 3 Tage Kompakt-Intensiv-Training
Das Training richtet sich an Personen, die Termine, Praxisnahe Ubungen und Tipps machen Sie
Kosten und Ressourcen mit den vielseitigen zu einem versierten Anwender von Microsoft
Werkzeugen von Microsoft Project professionell Office 2013.

verwalten wollen.

TRAININGSINHALTE TRAININGSINHALTE
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Grundlagen (1. Tag) Tag 1:
> Projektmanagement Basis > Einstieg in die neuen Benutzeroberflichen von Word, Excel,
> Einflhrung Arbeitsweise Outlook und PowerPoint 2013
> Arbeitsoberflache > Task Panes und Mentibander in Office 2013
> Basiseinrichtung > Backstage View
> Vorgénge anlegen > Live Preview wahrend der Bearbeitung
> Vorgangsverknlpfungen > Arbeiten in der Cloud
> Ressourcen anlegen und verknlpfen
) Filter erstellen und anwenden Tag 2:
> Ansichten, Masken und Tabellen Word 2013
> Neue Leseansicht

Aufbau (2. Tag) > Ausrichtungslinien und Echtzeitlayout
> Projektkalender > Task Panes
> Kapazitdtsabgleich der Ressourcen > Neue Funktionen bei Kommentaren und Uberarbeitungen
> Basispléane (»Einfaches Markup®)
> Projektverfolgung und Projektkontrolle > Nutzen von interaktiven Elementen
> Mit Kosten arbeiten > Funktion: Erweitern und Reduzieren
> Projektinformationen hervorheben
> Berichte erstellen Excel 2013

. > Neue Benutzeroberflache
Fortschritt (3. Tag) > Sparklines

> Ressourcenpool

> Einstieg in Multiprojektmanagement

> Benutzerdefinierte Felder mit Gliederungscodes,
Formeln und grafischen Indikatoren

> Softwarelibergreifender Datenaustausch

> Grafische Optimierung

> Praktische Tipps & Tricks

> Neue Funktionen in Excel

> Schnellanalyse der Daten

> Filter und Blitzvorschau

> Diagrammempfehlungen/Optimierung der Diagramme
> Neue Pivot-Tabellen

> Analysemdglichkeiten

> Neue Seitenlayoutansicht

VORAUSSETZUNGEN P boint 2013

> Neue Ubersichtliche Benutzeroberflache

Grundlagen: ) Verbesserte Referentenansicht
> Allgemeine PC-Kenntnisse > Onlineprasentation mit PowerPoint 2013

> Bild- und Filmbearbeitung unmittelbar in PowerPoint 2013
Aufbau und Fortschritt: > Optimierung der Mastergestaltung

> Jeweils die Inhalte der vorangegangenen Trainingseinheit
Outlook 2013
> Neue Benutzeroberflache
> Abwesenheitsassistent
> Besprechungsanfrage
> Planungsansicht
> Kategorien
> Neue Ansichten bei Kontakten
> Praktische Tipps & Tricks

VORAUSSETZUNGEN

> Kenntnisse und Erfahrungen aus der Vorgangerversion

Uber 1.000 weitere Trainingsthemen finden Sie auf www.medienreich.de! 27
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Microsoft Partner

ver Learning

Microsoft PowerPoint

GRUNDLAGEN - AUFBAU - FORTSCHRITT

3 Tage Spezial-Intensiv-Training

Lernen Sie in diesem Training, wie Sie mit dem am
weitesten verbreiteten Prasentationsprogramm
Microsoft PowerPoint Daten und Fakten
ansprechend vermitteln.

TRAININGSINHALTE

Grundlagen (1. Tag)

> Arbeitsoberflache von PowerPoint

> Autoinhalt-Assistent verwenden

> Textplatzhalter verwenden

> Hilfefunktionen

> Ansichten in PowerPoint nutzen

> Mit Folienarten arbeiten

> Bildschirmprasentationen erstellen und bearbeiten
> Arbeit mit Texten und Ansichten

> Textgestaltungen

> Formatierungen

> Uberarbeitung von Folientexten

> Prasentationen drucken und verwalten

Aufbau (2. Tag)

> Zeichen- und Grafikobjekte erstellen

> Organigramme und Diagramme erstellen und gestalten
> Prasentationen vorbereiten

> Entwurfsvorlagen und Master gestalten

> Prasentationen individualisieren

> Foliengestaltung und Designs

> Objektbearbeitung

> OLE-Objekte erzeugen, einfiigen und bearbeiten

Fortschritt (3. Tag)

> Schaltflachen verwenden

> Automatisierte oder manuell gesteuerte Uberblendungen
> Einsatz von Musik und Ténen in einer Prasentation
> Videosequenzen und Flashfilme einbinden

> Zielgesteuerte Navigationen erstellen

> Externe Verlinkungen verwenden

> Animationen einsetzen

> Diagramme animieren

> Présentationen im Team

> Onlinetibertragungen durchfiihren

> Praktische Tipps & Tricks

VORAUSSETZUNGEN

Grundlagen:
> Allgemeine PC-Kenntnisse

Aufbau und Fortschritt:
> Jeweils die Inhalte der vorangegangenen Trainingseinheit

Microsoft Partner

 Leaming

Microsoft Access

GRUNDLAGEN - AUFBAU - FORTSCHRITT

3 Tage Spezial-Intensiv-Training

In diesem Kurs lernen Sie das Erstellen von Daten-
banken und ihre Pflege, Datenselektion und eine
ansprechende und reprasentative Darstellung von
Daten mit Microsoft Access.

TRAININGSINHALTE

Grundlagen (1. Tag)

> Arbeitsoberflache

> Hilfefunktionen nutzen

> EinfUhrung in Datenbanken

> Navigationsbereich

> Formulare erstellen

> Tabellen erstellen und bearbeiten

> Daten in Formulare eingeben, bearbeiten und betrachten

Aufbau (2. Tag)

> Felddefintion und Feldeigenschaften

> Felddatentypen

> Daten suchen und auswerten

> Einsatz von Filtern

> Einsatz von Spezialfiltern

> Arbeit mit Abfragen

> Druck von Tabellen, Abfragen und Formularen
> Mit Berichten arbeiten

Fortschritt (3. Tag)

> Datenbanken verwalten

> Indizierung

> Beziehungen zwischen Tabellen

> Bearbeitung der Datenbankobjekte

> Datenbanken erstellen

> Datenbankobjekte bearbeiten

> Datenbanken effektiv nutzen

> Effiziente Arbeit mit anderen Microsoft Officeprodukten,
z.B. Serienbriefe und Etiketten mit Word und Access

> Praktische Tipps & Tricks

VORAUSSETZUNGEN

Grundlagen:
> Allgemeine PC- oder Mac-Kenntnisse
> Windows-Grundlagen

Aufbau und Fortschritt:
> Jeweils die Inhalte der vorangegangenen Trainingseinheit
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Termine/Preise entnehmen Sie bitte der Trainingszeiten: @edienrelch

beigefiigten Preis- und Terminibersicht. Jeweils von 09:30 — 17:00 Uhr

Microsoft Partner Microsoft Partner

Microsoft Access — -
Datenbankentwicklung

KOMPAKT GRUNDLAGEN — AUFBAU - FORTSCHRITT

Microsoft Outlook

3 Tage Kompakt-Intensiv-Training 3 Tage Spezial-Intensiv-Training
Als Schwerpunkte dieses Trainings lernen Sie die Dieses Training vermittelt Ihnen die einfachere
Datenbankentwicklung und die Datenbank- Organisation Ihrer Birokommunikation mit Microsoft
generierung als elementare Bestandteile von Outlook vom E-Mail-Versand tber die Termin-
Microsoft Access kennen. verwaltung bis zum effizienten Groupworking.

TRAININGSINHALTE TRAININGSINHALTE

LLl
=)
L.
L.
=)
—
(1
S
7}
o
o
]
=
I
—
LLl
S
=
=
a
=
Ll
=
=
<
S
=
‘o™

> Datenbankgrundlagen Grundlagen (1. Tag)

> Navigationsbereich > Arbeitsoberflache

> Tabellen erstellen und bearbeiten > Schnelleinstieg

> Felddefintion und Feldeigenschaften > Hilfefunktionen nutzen

> Felddatentypen > Ordnerstrukturen

> Datenblattansicht > E-Mail-Konten einrichten

> Suchen, Sortieren und Filtern > Nachrichten erstellen und versenden
> Indizierung > Nachrichten empfangen

> Beziehungen zwischen Tabellen > Dateianhéange

> Abfragen erstellen und bearbeiten > Mit dem Adressbuch arbeiten

> Standardformulare und -berichte > Visitenkarte und Signatur

> Druck aus Tabellen und Abfragen > Verwalten von Kontakteintragen
> Einsatz von Kriterien > Verteiler

> Abfragen mit Funktionen

> SQL-Abfragen Aufbau (2. Tag)

> Datenanalyse (Kreuz- und Pivot-Tabellen) > Kontakte in Word verwenden

> Daten visualisieren (Diagramme etc.) > Notizen

> Automatisieren > Kalender

> Makros _ » Termingestaltung

> Datenaustausch mit anderen Anwendungen > Profilverwaltung

> Mit OLE-Objekten arbeiten > Aufgabenverwaltung im Team

> Datenbankverwaltung » Organisation von Besprechungen
> Leistungsanalyse > Outlook-Ordner verwalten

> Access im Client/Server-Netzwerk > Nachrichten verwalten

> Praktische Tipps & Tricks
Fortschritt (3. Tag)

VORAUSSETZUNGEN > Such- und Filterfunktionen
> Journal-Eintréage

> Outlook-Elemente kategorisieren, suchen und sortieren
> Access-Grundlagen > Druckformate und Druckansichten verwenden

> Datentransfer

> Sicherheitseinstellungen

> Virenschutz

> Outlook individuell einrichten und nutzen

> Praktische Tipps & Tricks

VORAUSSETZUNGEN

Grundlagen:
> Allgemeine PC-Kenntnisse

Aufbau und Fortschritt:
> Jeweils die Inhalte der vorangegangenen Trainingseinheit

Uber 1.000 weitere Trainingsthemen finden Sie auf www.medienreich.de! 29
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Microsoft Partner

ver Learning

Microsoft Visio

GRUNDLAGEN - AUFBAU - FORTSCHRITT

3 Tage Spezial-Intensiv-Training

In diesem Seminar erfahren Sie alles liber die
zentralen Aspekte der populéren Visualisierungs-
software Microsoft Visio.

TRAININGSINHALTE

Grundlagen (1. Tag)

> Arbeitsoberflache

> Grundlagen der Zeichnungserstellung

> Shapes

> Schablonen

> Zeichenblatter

> Layer

> Text in Shapes und Zeichnungen einfiigen und formatieren
> Vorlagen

Aufbau (2. Tag)

> Netzwerkdiagramm

> Raumplan

> Organigramm

> Fluss- und Pivot-Diagramm
> Projektzeitpléane

> Gantt-Diagramme

> Erstellen eigener Stile

> Programmanpassungen

Fortschritt (3. Tag)

> Erstellen eigener Shapes

> Shape-Eigenschaften ansehen/andern
> Einfiihrung in Shape-Sheets

> Datenfelder

> Import/Export zu Access und Excel

> Export in HTML-Format

> Benutzerdefinierte Eigenschaftsfelder
> Arbeiten mit Berichten

> Austausch mit anderen Office-Programmen
> Praktische Tipps & Tricks

VORAUSSETZUNGEN

Grundlagen:
> Allgemeine PC-Kenntnisse

Aufbau und Fortschritt:
> Jeweils die Inhalte der vorangegangenen Trainingseinheit

Microsoft Partner

Silver Learning

Microsoft Word

GRUNDLAGEN - AUFBAU - FORTSCHRITT

3 Tage Spezial-Intensiv-Training

Wie Sie Microsoft Word im Berufsalltag noch
effizienter nutzen - von Automatisierung,
Formatierung bis zu erganzenden Programmen -,
lernen Sie in diesem Seminar.

TRAININGSINHALTE

Grundlagen (1. Tag)

> Arbeitsoberflache

> Textbearbeitungsgrundlagen

) Erfassen, Uberarbeiten und Korrigieren von Texten
> Hilfefunktion

> Textgestaltung

> Formatierung

> Grafiken einfiigen aus ClipArt, Datei
> Tabellen erstellen

> Dokumentverwaltung

> Drucken

Aufbau (2. Tag)

> Autotexte

> Rechtschreibung, Trennung, Synonyme
> Suchen und Ersetzen

> Platzhalter

> Ausdriicke

> Umstellen von Text

> Aufbau in Tabellen

> Rechnen mit Feldern

Fortschritt (3. Tag)

> Formatvorlagen erstellen
> Verzeichnisse erstellen

> Gliederungen erstellen

> Textmarken

> Hyperlinks generieren

> Dokumentvorlagen

> Grafiken bearbeiten

> Serienbriefe

> Praktische Tipps & Tricks

VORAUSSETZUNGEN

Grundlagen:
> Allgemeine PC-Kenntnisse

Aufbau und Fortschritt:
> Jeweils die Inhalte der vorangegangenen Trainingseinheit
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yyiCh muss in meinem Beruf mit
verschiedenen Buroprogrammen
umgehen konnen und habe
aufgrund des Trainings meinen
Wissensschatz sinnvol
erweltern kénnen

Foto: Yuri Arcurs@fotolia.com

BDDC-Stammschroer
Workshop

,Es war einfach ok. Der Trainer war
sehr bemiiht sein Wissen weiterzu-
geben, und keine Frage blieb unbe-
antwortet. Mir hat es gut gefallen,

und wenn wieder geschult werden
muss, werde ich sicherlich medien-
reich damit beauftragen.”

Stadtverwaltung Raunheim
Workshop

,Der Trainer hat sich absolut auf
meine Bedlrfnisse eingestellt und
das in seiner Vorbereitung beriick-
sichtigt. Er hat sein Arbeitstempo
und den Seminarinhalt sehr gut
angepasst. So werde ich das vor
mir liegende Projekt sicher und ziel-
strebig angehen kénnen.”

Kolner Bank eG
OpenOffice Impress

»~Was war gut: Zu Beginn wurden
die Erwartungen und die Wiinsche
abgefragt.”

BUROANWENDUNGEN — SONSTIGE
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MindManager

KOMPAKT

2 Tage Kompakt-Intensiv-Training

In dem Seminar erfahren Sie, wie Sie mit dem
MindManager visuelle Mindmaps erstellen kénnen,
um ldeen zu erfassen, effizienter zu planen und mit

anderen besser zu kommunizieren.

TRAININGSINHALTE

> Mind-Mapping im Alltag

> Grundregeln des Mind-Mappings

> Von der Mind-Map zur Business-Map oder
»Der Weg vom Papier zum PC*

> Struktur von MindManager

> Grundlagen der Navigation

> Benutzeroberflache (Titelleiste, Symbolleiste
sowie Mendileiste)

> Map-Organisation

> Map-Vorlagen

> Grundregeln fir die erste Map

> Zweigformatierung

> Bilder in MindManager

> Zweignotizen

> Map Parts ,,Die Kategorien*

> Praktische Tipps & Tricks

VORAUSSETZUNGEN

> Windows- und MS-Office-Kenntnisse

Lotus Notes

GRUNDLAGEN - AUFBAU - FORTSCHRITT

3 Tage Spezial-Intensiv-Training

Dieser Kurs vermittelt die grundlegenden Kenntnis-
se fur die Verwendung des Datenbanksystems IBM
Lotus Notes als Umgebung zum Informationsaus-
tausch und zur Erstellung von Daten.

TRAININGSINHALTE

Grundlagen (1. Tag)

> Notes-Arbeitsoberflache und ihre Komponenten
> Navigieren im Notes-Arbeitsbereich

> Mails senden, empfangen, verwalten

> Kalenderfunktionen

> Verwaltung von Aufgabenlisten

> Vorgaben fiir Mail, Kalender, Aufgaben

> Einrichtung einer persénlichen Arbeitsoberflache

Aufbau (2. Tag)

> Dokumentgestaltung

> Arbeiten mit Adressbuchern (personlich, 6ffentlich)

> Verwenden der Notes-Hilfen

> Notes-Datenbanken

> Verwalten und Auffinden von Dokumenten in
Datenbanken

Fortschritt (3. Tag)

> Formatvorlagen erstellen und verwenden

> Tabellen, Grafiken, Hotspots erstellen

> Kalender- und Aufgabenansichten verwenden

> Kalendereintrage hinzufligen und verwalten

> Erstellen, Beantworten, Verwalten von Einladungen
> Erstellen, Zuordnen und Verwalten von Aufgaben

> Gruppenaufgaben bearbeiten

> Sicherheitseinstellungen

> Praktische Tipps & Tricks

VORAUSSETZUNGEN

Grundlagen:
> Allgemeine PC-Kenntnisse

Aufbau und Fortschritt:
> Jeweils die Inhalte der vorangegangenen Trainingseinheit
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Termine/Preise entnehmen Sie bitte der Trainingszeiten: E’diE’ﬂ/’E’lCh
beigefiigten Preis- und Terminiibersicht. Jeweils von 09:30 — 17:00 Uhr COMPUTERTRAININGS

think-cell OpenOffice — Im Uberblick

KOMPAKT KOMPAKT

1 Tag Kompakt-Intensiv-Training 1 Tag Kompakt-Intensiv-Training
In unserer think-cell Schulung erfahren Sie In diesem Kurs lernen Sie die wichtigsten
Nutzliches Uber das Erstellen tiberzeugender Facetten von OpenOffice im Vergleich zu
Geschaftsprasentationen. anderen Office-Paketen.

TRAININGSINHALTE TRAININGSINHALTE
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> Verschiedene Diagramme von think-cell chart: > Hauptmerkmale von OpenOffice
e Gestapeltes/gruppiertes Saulendiagramm > Wesentliche Unterschiede zu anderen Officepaketen
¢ Wasserfalldiagramm (z.B. MS Office)
* Marimekko > Vorstellung des Gesamtpaketes:
e Flachen-, Linien-, Torten-, Punkte-, Blasen-Diagram e OpenOffice Writer
e Gantt * OpenOffice Calc
> Arbeiten mit dem internen Datenblatt e OpenOffice Base
> Farben * OpenOffice Impress
> Daten-Verkniipfung mit Microsoft Excel ¢ OpenOffice Draw
> Arbeiten mit Microsoft PowerPoint-Benutzern ¢ OpenOffice Math
ohne think-cell > Onlinedokumentation und Hilfe von OpenOffice

> Rechtliches

> Praktische Tipps & Tricks
VORAUSSETZUNGEN
> Grundlegende Kenntnisse in PowerPoint und Excel VORAUSSETZUNGEN

> Allgemeine PC-Kenntnisse

Uber 1.000 weitere Trainingsthemen finden Sie auf www.medienreich.de! 33
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IBM SPSS Statistics Das iPad und Keynote

KOMPAKT KOMPAKT

2 Tage Kompakt-Intensiv-Training 1 Tag Kompakt-Intensiv-Training
Lernen Sie in unserer SPSS-Statistics Schulung, wie Erfahren Sie alles liber das iPad als Gerat zum
Sie die Statistiksoftware von IBM optimal nutzen. Erstellen und zur Vorfiihrung von Préasentationen.

TRAININGSINHALTE TRAININGSINHALTE
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> Kennenlernen der SPSS-Programmfenster > Kurziberblick: Keynote fur den Mac
> Daten-Editor (Datenansicht und Variablenansicht) > Wichtige Einstellungen: Keynotes auf dem Mac fur die
> Ausgabe-Fenster iPad-Nutzung vorbereiten
> Variablen definieren, Daten eingeben > Keynote-Prasentationen vom Mac auf das iPad
> Daten filtern Ubertragen
> Variablen umcodieren > Keynote-Prasentationen auf dem iPad erstellen:
> SPSS-Syntax ein Schnelleinstieg
> Haufigkeitsanalyse > Oberflache der App
> Ausgewabhlte statistische Verfahren: > Erstellen von Folien
¢ Kreuztabelle mit Chi-Quadrat-Test > Texte erstellen und Schrift-Formatierung
e Test auf Normalverteilung > Einbetten von Bildern und Grafiken
e t-Test flir abhdngige und unabhangige Stichproben > Animationen und Folienlibergénge
¢ Varianzanalyse > Préasentieren mit den iPad
* Regressionsanalyse, Korrelationsanalyse > Fernsteuern einer Présentation mit Keynote Remote vom
e Faktorenanalyse iPhone und Co.
¢ Nicht parametrische Tests > Wiedergabe einer Prasentation Uber Beamer oder
> Praktische Tipps & Tricks GroBbild-TV

> Praktische Tipps & Tricks

VORAUSSETZUNGEN
> Grundlegende Kenntnisse der genannten statistischen VORAUSSETZUNGEN

Verfahren.
> Fir diese Schulung ist der Besitz eines iPads
notwendig, da die Teilnehmer auf ihrem eigenen
Gerat geschult werden.

34 Alle Trainings bieten wir lhnen auch als individuelle Inhouse und Firmen Trainings an.



spe - Beratungs- und
Entwicklungsgesellschaft mbH
Windows - Fiir Anwender

»Der Trainer war sehr kompetent und
didaktisch gut.”

yyDurch das Intensiv-Training
kann ich nun das neue
Betriehssystem unserer Firma
deutlich besser nutzen bk

VBL
Windows Professional

~Was war gut: kleiner Kreis; genug
Zeit fur alle Fragen; Unterrichtsma-
terial war versténdlich und umfas-

send.”

Microsoft Partner

Silver Learning

Hesse & Partner GmbH
Windows-Workshop

,Die Trainerin hat sehr verstédndlich
erkldren kénnen.”

MICROSOFT BETRIEBSSYSTEME
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Microsoft Partner

ver Learning

Microsoft Windows 7

KOMPAKT

1 Tag Kompakt-Intensiv-Training

Lernen Sie in diesem Workshop grundlegende
Fahigkeiten fiir Microsoft Windows 7 und wie Sie
das weitverbreitete Betriebssystem effizient bei der
taglichen Arbeit am PC einsetzen und nutzen.

TRAININGSINHALTE

> Grundlagen von Windows

> Uberblick tiber die Versionen

> Benutzeroberflache

> Explorer

> Systemsteuerung

> Taskmanager

> Dateien und Ordner

> Drucken

> Arbeitstechniken

> Netzwerke und Datensicherheit
> Datentrager und Datensicherung
> Benutzerverwaltung

> Ressourcenverwaltung

» Zusatzprogramme

> Jump Lists im Startmeni

> Gadgets

> Hilfefunktionen

> Praktische Tipps & Tricks

VORAUSSETZUNGEN

> Aligemeine PC-Kenntnisse

Microsoft Partner

Silver Leaming

Microsoft Windows 7 —
Umstieg fiir Administratoren

KOMPAKT

2 Tage Kompakt-Intensiv-Training

Dieses Training vermittelt Ihnen die notwendigen
Kenntnisse, um das neue Microsoft-Betriebssystem
Windows 7 unternehmensweit effizient einzurichten

und zu administrieren.

TRAININGSINHALTE

> EinfUhrung in die verschiedenen Versionen und deren
Besonderheiten

> Vorbereitung und Hardwarevoraussetzungen

> Upgrade-, Lizenzierungs- und Aktivierungsmodelle

> Zertifikatsdienste

> Installationsarten (Datentrager und/oder Netzwerk
als Installationsquelle)

> Benutzerkonten und deren Absicherung

> Konfiguration der Bedienoberflache

> Sicherheitseinstellungen (Windows Firewall
und Defender)

> Einbindung des Clients in das Firmennetzwerk

> Netzwerkeinstellungen und -profile

> Freigaben und Netzlaufwerke

> Installation und Verwaltung angeschlossener Gerate

> Management Console und wichtige
Kommandozeilen-Tools

> Systemwiederherstellung und Sicherung der
Installation (Backup)

> Application-Compatibility-Toolkit (ACT)

> Registry

> .NET Framework

> Windows-Bereitstellungsdienste (WDS)

> Direct Access

> Praktische Tipps & Tricks

VORAUSSETZUNGEN

> Grundlegende Kenntnisse der Windows-Administration der
Vorgéngerversionen
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Termine/Preise entnehmen Sie bitte der Trainingszeiten: @edienrelch

beigefiigten Preis- und Terminibersicht. Jeweils von 09:30 — 17:00 Uhr
Migﬁsoft Partner MiE:’mC:SOﬁ Partner

Microsoft Windows 7 - Effektiver Umstieg

Umstieg fiir Anwender auf Windows 8 und Office 2013

KOMPAKT KOMPAKT
1 Tag Kompakt-Intensiv-Training 3 Tage Kompakt-Intensiv-Training
Der Kurs macht Sie mit den Neuerungen des Sie erhalten einen kompakten Uberblick (iber das
aktuellen Microsoft-Betriebssystems Windows 7 neue Betriebssystem und Office 2013 von Microsoft.

gegentiiber den Vorgéngerversionen XP
und Vista vertraut.

TRAININGSINHALTE TRAININGSINHALTE
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) Einfiihrung in die grundlegenden Neuerungen Einfithrung in die neue Oberfliche von Windows 8:
gegenuiber den Vorgangerversionen > Menuband im Windows Explorer

> Benutzeroberflache > Ordner und Dateien

> Neue Funktionen > Windows 8 Bedienung mit dem Touchscreen oder Tablet

> Optionen zur Fenstertechnik > Apps und Store-Integration

> Jump Lists > Arbeiten im Team

> Bibliothek > Pflege des Systems

> Systemsteuerung > Schutz des Systems

> Geratemanager

> Geratecenter Neues in Office 2013:

> Gadgets > Bedienung

> Kompatibilitat > Dateien

> Internet Explorer 8 > Arbeiten im Team

> XP Mode > Bedienung mit dem Touchscreen

> Sicherheitseinstellungen

) Hilfefunktionen Word 2013:

> Praktische Tipps & Tricks > Einstieg in die Benutzeroberflache

> Allgemeine Textbearbeitung

VORAUSSETZUNGEN S Vodsgan’®

> Verzeichnisse
> Anwenderkenntnisse im Bereich Windows > Drucken

> Excel 2013:

> Neue Benutzeroberflache
> Task Panes

> Menlband

> Filter und Blitzvorschau

> Diagramme

> Sparklines

Outlook 2013:

> Abwesenheitsassistent

> Besprechungsanfrage

> Planungsansicht

> Kategorien

> Neue Ansichten bei Kontakten

PowerPoint 2013:

> Neue Benutzeroberflache
> Task Panes

> Neue Folienlibergange

> Screenshots einfligen

> Office-Objekte einfligen
> Referentenansicht

VORAUSSETZUNGEN

> Grundlagenkenntnisse der vorherigen Versionen

Uber 1.000 weitere Trainingsthemen finden Sie auf www.medienreich.de! 37



@gdienreicg

www.medienreich.com
E-Mail: info@medienreich.com

Hotline Deutschland 0800-5550116 kostenfrei
Hotline Osterreich 0820-400120 € 0,12/Min.

Ll
=
LLl
—
(¢
>=
(7]
(7]
2]
—
o
—
LLl
(aa]
—
L.
(=}
(7]
(=}
cc
=
=

Microsoft Partner

Microsoft Windows 8 —
Fiir Anwender

KOMPAKT

2 Tage Kompakt-Intensiv-Training

Diese Schulung stattet Sie mit dem notigen Wissen
aus, um das neue Betriebssystem von Microsoft
professionell bedienen zu kénnen.

Microsoft Partner

" Microsoft Windows Server 2012
Administration — Grundlagen

KOMPAKT

5 Tage Kompakt-Intensiv-Training

Sie lernen die wichtigsten Grundlagen zur
Administration von Windows Server 2012.

TRAININGSINHALTE TRAININGSINHALTE

> Die Windows 8 Oberflache kennenlernen
> Der neue Windows-Explorer

> Desktop und Desktop-Apps

> Der neue Task-Manager

> Windows 8 Apps benutzen

> Windows mit Gesten steuern (Touchscreen-Bedienung)
> Action Center nutzen zur Problemlésung
> Suche und Schnellinfos

> Microsoft Windows Store

> Windows 8 individuell einrichten

> Virenschutz mit Windows Defender

> Windows 8 auf mobilen Endgeréaten

> Windows 8 to go

> Praktische Tipps & Tricks

VORAUSSETZUNGEN

> Allgemeine PC-Grundlagenkenntnisse

> Windows Server 2012 installieren (Update)

> Installation und Verwaltung von Active Directory Services

> Benutzer- und Computerkonten verwalten

> Erstellung und Verwaltung von Gruppen

> Gruppenrichtlinien

> Drucker und Freigaben einrichten

> Dateisystem ReFS (in Erganzung zu NTFS)

> Domain Name System (DNS) und Domain Name System
Security Extensions (DNSSec)

> DHCP

> ISCSI/ DFS / IPv6

> SMB und NFS: Neue Funktionen

> Internet Information Server 8.0(IIS) / Remote Desktop

> Ubersicht tiber Hochverfiigbarkeit

> Hyper-V und Hyper-V Replica

> Backup und Recovery

> Festplattenverschllsselung mit Bitlocker

> Installation und Deinstallation der GUI

> Cluster Shared Volume (CSV)

> Praktische Tipps & Tricks

VORAUSSETZUNGEN

> Administratorkenntnisse der vorherigen Serverversionen
sind hilfreich
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PEAG Transfer GmbH
C++ - Grund- und Aufbaukurs

,Irainer ist flexibel auf aktuelle Fra-
gen, Themen und Anderungswiin-
sche eingegangen. Viel praktisches
Arbeiten hat fiir ein kurzweiliges

Seminar gesorgt.”

y3Was mir besonders
gut gefallen hat, war
die praxisorientierte
Ausrichtung des Kurses £

Foto: nyul@fotolia.com

Deutsche Vermdgensberatung AG Axtesys

Java - Grundlagen

Java und SQL Spezial-Intensiv-
Training

»Der Trainer war sehr geduldig mit
den Teilnehmern und hat den »ES war die beste Schulung, die ich
Lehrstoff sehr gut vorbereitet und seit Langem hatte. Meinen besonde-

unterrichtet.”

ren Dank an den Trainer, der mir den
Stoff bersichtlich und verstédndlich
beigebracht hat.”
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Visual C# -
Grundlagen — Aufbau

KOMPAKT

3 Tage Kompakt-Intensiv-Training

In diesem Training lernen Sie von Grund auf den
Umgang mit Visual C#, der von Microsoft ent-
wickelten, objektorientierten Programmiersprache.

TRAININGSINHALTE

> Einflhrung in Visual C# und Visual Studio 2010 bzw. 2012

> Syntax

> Bezeichner und Schliisselworte

> Aufbau eines Programms

> Dokumentation des Programmcodes

> Anweisungen erstellen

> Einfache Datentypen

) Literale

> Variablen

> Typkompatibilitédt und Typkonversion

> Konstanten

> Operatoren

> Kontrollstrukturen

> Einfihrung in objektorientiere Programmierkonzepte
(Klassen, Objekte, Kapselung)

> Praktische Tipps & Tricks

VORAUSSETZUNGEN

> Vorkenntnisse in anderen Programmiersprachen, wie C++,
sind von Vorteil

Java -
Grundlagen — Aufbau

KOMPAKT

5 Tage Kompakt-Intensiv-Training

Das praxisnahe Training vermittelt fundierte Grund-
kenntnisse, um eigene Applikationen und Applets in
der Programmiersprache Java zu verwirklichen.

TRAININGSINHALTE

Einfithrung in eine Entwicklungsumgebung (Netbeans oder
Eclipse)

Grundlegende Sprachelemente
> Ein- und Ausgabe

> Operatoren

> Kontrollstrukturen

Grundlagen der objektorientierten Programmierung (00P)

Objektorientierung in Java
> Pakete

> Klassen, Objekte

> Methoden und Attribute

> Prinzip der Kapselung

Fortgeschrittene Konzepte der Objektorientierung

> Vererbung

> Polymorphismus

> Schnittstellen und Adapterklassen

> Generische Datentypen

> Einfache Entwurfsmuster

> Fehlerbehandlung mit Exceptions und Asserts

> Collections-Framework, Arrays und Aufzahlungstypen
in Java

) Effizientes Arbeiten mit Zeichenketten

> 1/0-Programmierung mit Streams und Datei-Klassen

> Arbeiten mit weiteren nitzlichen Klassen des
Java-Frameworks

> Praktische Tipps & Tricks

VORAUSSETZUNGEN

> Programmierkenntnisse von Vorteil
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Visual C++ - Visual Basic -

Grundlagen — Aufbau Grundlagen — Aufbau
KOMPAKT KOMPAKT s
—
=
3 Tage Kompakt-Intensiv-Training 3 Tage Kompakt-Intensiv-Training 5
In diesem Kurs erlernen Sie die Grundkenntnisse Dieses Training fiihrt Sie Schritt fiir Schritt in die E
der meistgenutzten Programmiersprache Anwendungsentwicklung mit Microsoft Visual Basic L
weltweit: C++. ein, egal ob Sie versierter Windows-Anwender E
oder Anfénger sind. ;
=
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o
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TRAININGSINHALTE TRAININGSINHALTE

> Entstehung von C++ > Grundbegriffe der Programmierung
> C++ und der ANSI-Standard > Die Visual-Basic-Entwicklungsumgebung
> Sprachkonzepte und Syntax > Erste Schritte mit Visual Basic

> Deklarationen > Benutzeroberflachen

> Variablen und Datentypen > Anlegen eines Projektes

> Konstanten und Operatoren > Kontrollstrukturen

> Zeiger > Benutzerfihrung

> Referenzen > Datentypen

> Dynamische Speicherverwaltung > Prozeduren

> Referenzen und Referenzvariablen > Funktionen

> Streams > Schleifen

> Funktionen und Klassen > Gltigkeitsbereiche

> Klassenhierarchien > Arrays

> Konstruktoren und Destruktoren > Klassen

> Instanzen und Objekte > Objekte

> Vererbung > Steuerelemente

> Polymorphismus > Debugging

> Datei- und Stringstreams > Grafiken

> Praktische Tipps & Tricks > Multimedia

> Praktische Tipps & Tricks

VORAUSSETZUNGEN
VORAUSSETZUNGEN

> Programmierkenntnisse in anderen Sprachen
sind von Vorteil > Grundlagen- und Aufbauwissen

Uber 1.000 weitere Trainingsthemen finden Sie auf www.medienreich.de! 4
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Perl - SharePoint 2010 -
Grundlagen — Aufbau Fiir Entwickler
e KOMPAKT KOMPAKT
—
2
5 3 Tage Kompakt-Intensiv-Training 2 Tage Kompakt-Intensiv-Training
E Das Training richtet sich an Grafiker, Programmierer In dieser Schulung erhalten Sie einen Uberblick
1] und Perl-Einsteiger, die im Entwicklungsbereich tiber die Anwendungsentwicklung in Microsoft
E arbeiten und einen fundierten Einstieg in die SharePoint 2010.
; Programmiersprache Perl suchen.
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TRAININGSINHALTE TRAININGSINHALTE

> Einflhrung in Perl Y Einfiihrung und Uberblick

> Grundlagen der Perl-Programmierung > Benutzeroberflache

> Daten- und Kontrollstrukturen > Userinterface-Features und Arbeiten mit dem Ribbon
> Datentypen > SharePoint-Projektvorlagen in Visual Studio 2010
> Variablen > Sandbox-Konzepte

> Ein- und Ausgabe > Entwickeln mit LINQ und REST

> Listen und Arrays > Client Object Model

> Regulére Ausdriicke > JavaScript Object Model

> Funktionen > Silverlight Object Model

> Modularisierung > Business Connectivity Services-Applikationen

> Datenbankzugriffe entwickeln und bearbeiten

> Praktische Tipps & Tricks > Mit SharePoint Designer 2010 Workflows erstellen

und bearbeiten

> Praktische Tipps & Tricks
VORAUSSETZUNGEN
> Programmierkenntnisse und HTML-Kenntnisse VORAUSSETZUNGEN

> Programmierkenntnisse in SharePoint 2007
> Kenntnisse der .NET-Programmierung

42 Alle Trainings bieten wir lhnen auch als individuelle Inhouse und Firmen Trainings an.



yyUas intensive Iraining
hat uns geholfen, die
Datenbankverwaltung in
unserer Firma zu optimieren &6

Foto: nyul@fotolia.com

BioCon Invest
Access Grundlagen

,Die Trainerin konnte in der kurzen

Zeit alle Fragen gut beantworten und

sehr individuell auf unsere eigenen
Datenbankfragen eingehen.”

IE Group Miinchen GmbH
Access Grundlagen

,Flr den ersten Kontakt mit Access
2003 war es genau die richtige

Dosierung von Theorie (Datentypen,

Datenstrukturen) und Praxis (gute

Ubungen zum Arbeiten mit einer
Datenbank).”

Die Bergische Krankenkasse
Access

,Der Dozent ist auf individuelle Fra-
gen sofort und intensiv eingegan-
gen.”
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FileMaker

GRUNDLAGEN - AUFBAU — FORTSCHRITT

3 Tage Spezial-Intensiv-Training

Das Training verschafft Ihnen Einblicke in Idee,
Anwendungsméglichkeiten und Vorteile der
modernen und flexiblen Informations-
managementlésung FileMaker.

TRAININGSINHALTE

Grundlagen (1. Tag)

> Grundlagen der Datenbankerstellung
> Erstellen von Tabellen

> Beziehungen erstellen und definieren
> Feldtypendefinitionen

> Umgang mit Container-Feldern

> Arbeiten mit Datensatzen

> Importieren und Exportieren

> Suchen und Sortieren von Daten

Aufbau (2. Tag)

> Wertelisten erstellen

> Drucken

> Speichern

> Reporterstellung

> Rechnen mit FileMaker Pro

> Grundlagen des Scriptings in FileMaker Pro,
Script-Trigger

> Uberblick Relationale Datenbanken

Fortschritt (3. Tag)

> Remote Administration

> Einsatz in Netzwerken

> Import und Export von XML-Daten

> Verwaltung von Multimediadaten und digitalen Bildern
> Neueste Programmfunktionen

> Praktische Tipps & Tricks

VORAUSSETZUNGEN

> Grundlagenkenntnisse in Mac OS
> Grundlagenkenntnisse Datenbanken

PHP & MySQL

KOMPAKT

3 Tage Kompakt-Intensiv-Training

Im Seminar erwerben Sie die notwendigen
Kenntnisse fir die effektive Verbindung der
Skriptsprache PHP mit der Datenbank MySQL.

TRAININGSINHALTE

> ,Was ist eine relationale Datenbank?“ — ER-Modelle,
Datenbank-Modell

> Entwurf einer Datenbank, Datentypen

> SQL (SELECT, INSERT, UPDATE, DELETE, ...)

> Beispiel-Projekt: Erstellen eines Feedback-Formulars

> Entwurf der Datenbank

> Erstellen von HTML-Formularen

> Datenbankzugriff, Speichern der Daten mit
PHP-Funktionen

> Verbindung herstellen

> Anfragen abschicken

> Ergebnisse anfordern

> Ergebnisse mit PHP auswerten

> Automatisches Versenden der Ergebnisse per E-Mail
(Mail-Funktion)

> Logging & Fehlerbehandlung

> Optimierung einer Datenbankstruktur (,Normalisieren®,
Fremdschlissel)

> Optimierung der SQL-Abfragen

> Geschwindigkeitsoptimierung (Performance)

VORAUSSETZUNGEN

> PHP und HTML
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Termine/Preise entnehmen Sie bitte der Trainingszeiten: E’diE’ﬂ/’E’lCh
beigefiigten Preis- und Terminiibersicht. Jeweils von 09:30 — 17:00 Uhr COMPUTERTRAININGS

MySQL Oracle

KOMPAKT KOMPAKT

—

1T

=

3 Tage Kompakt-Intensiv-Training 5 Tage Kompakt-Intensiv-Training g
&

Der Kurs vermittelt das nétige Know-how zur In diesem umfassenden und praxisorientierten E
Installation und Funktion von relationalen Intensiv-Training erlernen Sie unter anderem (=]

Datenbanken und bietet eine kompakte den Aufbau einer Oracle-Datenbank und
Einfiihrung in MySQL. deren Verwaltung.

TRAININGSINHALTE TRAININGSINHALTE

> Datenbankgrundlagen > Architektur der Oracle-Datenbank (kurzer Uberblick)
> Grundkomponenten einer SQL-Anwendung > Administration der Datenbank

> Konfiguration > Oracle Database Assistant

> Datenmodellierung > Datenbankobjekte

> SQL-Kommandos > Datendefinition mit SQL

> Installation und Datenbankentwurf > Datenmanipulation mit SQL

> Aufbau einer Datenbank > Datensortierung mit SQL

> Tabellen anlegen > Transaktionssteuerung

> Realisierung von Benutzerschnittstellen > Komplexe Datenabfrage mit SQL
> Administration > Unterabfragen mit SQL

> Sicherheit und Backup > Prozeduren

> Anwendungsentwicklung unter Windows > Benutzerschnittstelle SQL*Plus

> SQL-Abfragen > Ausgabe mit SQL*Plus

> Praktische Tipps & Tricks > Benutzerverwaltung und -rechte

> Oracle Security Manager

> Tabellenerstellung und -verwaltung
VORAUSSETZUNGEN > Views
> Backup-Strategien

> Weitere Oracle-Werkzeuge (Uberblick)
> Praktische Tipps & Tricks

VORAUSSETZUNGEN

> Praktische Erfahrungen mit Datenbanken sind von Vorteil

> Aligemeine PC- und HTML-Kenntnisse

Uber 1.000 weitere Trainingsthemen finden Sie auf www.medienreich.de! 45
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PostgreSQL -
Fiir Administratoren

KOMPAKT

3 Tage Kompakt-Intensiv-Training

Lernen Sie in diesem Training das PostgreSQL-
Datenbanksystem erfolgreich zu installieren und
Datenbanken zu administrieren.

TRAININGSINHALTE

> Einflhrung in die Architektur von PostgreSQL unter
Linux oder Windows

> Installation von PostgreSQL

> Verwaltung und Konfiguration von:
¢ Administration von Benutzern und Benutzerrechten
e Sicherheitsaspekten
e (Festplatten-)Speicherplatz
e | aufzeitparameter
° pgAdmin

> Kontrolle und Instandhaltung der PostgreSQL-Datenbank

> Backup- und Wiederherstellungsmaoglichkeiten

> Performanceoptimierung

> Datenimport

> Mit Indizes arbeiten

> Daten manipulieren

> Abfragen

> Vorstellung nutzlicher Tools und Werkzeuge fiir
PostgreSQL

> Praktische Tipps & Tricks

VORAUSSETZUNGEN

> Linux- Kenntnisse
> Datenbank- und SQL-Kenntnisse

SQL -
Grundlagen und Datenbankdesign

KOMPAKT

5 Tage Kompakt-Intensiv-Training

Der Kurs vermittelt das nétige Wissen zur Installa-
tion und Funktion von relationalen Datenbanken
und bietet eine kompakte Einflihrung in SQL.

TRAININGSINHALTE

> EinfUhrung relationale Datenbanken

> Einfihrung SQL

> Datenbankentwurf

> Datenmodell, ER-Modell

> Primarschlissel, Fremdschlissel und Indizes

> Integritat

> Datenbank- und Tabellendefinitionen, Datentypen
> Tabellen erstellen und verwalten

> Daten bearbeiten (Einfligen, Bearbeiten, Léschen)
> Datenabfragen (SELECT, WHERE)

> Datenabfragen aus mehreren Tabellen (JOIN)

> Unterabfragen

> Cursor

> Sichten

> Routinen und Trigger

> Transaktionen

> Benutzer-/Rechteverwaltung und Zugriffsschutz
> SQL-Syntax géangiger Datenbanken

> Praktische Tipps & Tricks

VORAUSSETZUNGEN

> Grundkenntnisse zu Datenbanken
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yyUas intensive Iraining hat mir
dank der richtigen Fokussierung
weitergenolfen, dieses
Betriehssystem zu verstehen &k

tecops personal GmbH
Linux Grundlagenschulung

»,Gut gefallen hat mir, dass der Trai-
ner intensiv auf Fragestellungen
eingegangen ist und diese mit in die

Schulung eingebaut hat. Die Erkl&-
rungen waren alle sehr verstdndlich
und zielfiihrend. Es hat sehr viel
SpaB gemacht in sympathischer
Atmosphére.”

Foto: contrastwerkstatt@fotolia.com

VDMA Verlag
FTP/Apache Web Server
Training

»Der Trainer hat es hervorragend
verstanden, den theoretischen
Stoff zu vermitteln und diesen mit
konkreten VDMA-Fragen zu verbin-
den. Er hat sich ein gutes Bild tiber
den Wissensstand der Teilnehmer
gemacht und das Tempo entspre-
chend angepasst.”

ILL
Linux Grundlagen und
Administration

»Was war gut: Die kleine Gruppe von
2 Leuten durch die Inhouse Schu-
lung direkt bei uns.*”
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www.medienreich.com
E-Mail: info@medienreich.com

Hotline Deutschland 0800-5550116 kostenfrei
Hotline Osterreich 0820-400120 € 0,12/Min.

Q@@edienreich

COMPUTERTRAININGS

Linux

KOMPAKT

Linux Ubuntu — Administration

KOMPAKT

>
1
=
; 3 Tage Kompakt-Intensiv-Training 5 Tage Kompakt-Intensiv-Training
=
= Dieses Training vermittelt Ihnen fundamentale Lernen Sie die professionelle Administration
Grundkenntnisse fiir die Funktionsweise und der beliebten Linux-Distribution im
Administration des Linux-Betriebssystems. Kompakt-Intensiv-Training.
TRAININGSINHALTE TRAININGSINHALTE
> Linux-Dateisystem > Installation des Betriebssystems
> Einfache Dateiverwaltung > Einfihrung, Einrichtung und Verwaltung des
> Grafischen Oberflache anpassen und anwenden Linux-Dateisystems
> Linuxkommandos > Wie kann ich die Oberflache konfigurieren?
> Standardanwendungen mit der grafischen > Einrichten und Verwalten des Linux-Dateisystems
Oberflache ausfiihren > Wie ist das Dateiysystem aufgebaut?
> Textdokumente mit dem Editor vi 6ffnen, > Welche Datentypen gibt es?
bearbeiten und speichern > Partitionen
> Dateizugriffsrechte > Mounten
> Drucken: Kommandos und Werkzeuge > Benutzer(gruppen)datenbank verwalten
> X-Server anpassen > Grand Unified Bootloader (1 und 2)
> Grundlegende Shellprogrammierung > Linux Shell im Einsatz
> Arbeiten mit Disketten > Netzwerk einrichten und konfigurieren
> RPM-Verwaltung und Debian-Paketverwaltung > Wie binde ich die Workstation in das Netzwerk ein?
> Netzwerkanwendungen > E-Mail-Dienste einrichten und konfigurieren
> Utilities fiir Fortgeschrittene, Prozessverwaltung, > Sicherheit im Netzwerk und im System
Optimierung > Prozess- und Speichermanagement
> Fehlerbehandlung und Reparaturen
> Lokales Drucken und im Netzwerk drucken
VORAUSSETZUNGEN » Samba kennenlernen und einsetzen
> Backups
. . > Log-Files auswerten
> Aligemeine PC-Kenntnisse > Bash programmieren und konfigurieren
> Praktische Tipps & Tricks
VORAUSSETZUNGEN
> Grundkenntnisse in Linux
48 Alle Trainings bieten wir lhnen auch als individuelle Inhouse und Firmen Trainings an.



Termine/Preise entnehmen Sie bitte der
beigefiigten Preis- und Terminibersicht.

Trainingszeiten:
Jeweils von 09:30 — 17:00 Uhr

@edienreich

COMPUTERTRAININGS

Datei- und Druckserver mit Linux
(Samba)

KOMPAKT

3 Tage Kompakt-Intensiv-Training

In diesem Training erhalten Sie die notwendigen
Kenntnisse, um Linux mithilfe des beliebten
Samba-Paketes als Datei- und Druckserver

einzusetzen.

TRAININGSINHALTE

> Grundlagen

> Ubersicht {iber Protokolle und Domanen

> NetBIOS-Namensauflésung

> Authentifizierung und Zugriffsrechte

> Einsatz in Windows-Domanen

> Samba als Dateiserver im Windows-Netzwerk

> SMB-Druckserver und Drucken unter Linux (CUPS)
> Linux als UNIX-Dateiserver und Dateisystem-Client
> RPC (Remote Procedure Calls)

> NFS (Network File System)

> Automounter im Einsatz

> Praktische Tipps & Tricks

VORAUSSETZUNGEN

> Fundierte Kenntnisse im Bereich Linux und Netzwerke

Debian GNU/Linux —
Administration

KOMPAKT

3 Tage Kompakt-Intensiv-Training

Lernen Sie in dieser Debian-Schulung, wie Sie
das beliebte Betriebssystem professionell
administrieren.

LINUX / UNIX

TRAININGSINHALTE

> Was ist eigentlich das Debian-Projekt?

> Installation und Einrichtung von Debian

> Einrichtung und Verwaltung des Linux-Dateisystems

> Lokale Benutzerverwaltung

> Pflege der Benutzer(gruppen)datenbank

> Automatische Installation

> Initialisierung des Systems

> Bootvorgang

> Verwaltung, Reparatur und Uberpriifung der
Festplatten und Dateisysteme

> Konfiguration von X-Server, NFS, Automounter,
KDE und Gnome

> Einrichtung und Konfigruation E-Mail-Dienste

> Fehlerbehandlung

> System- und Netzwerksicherheit

> Backup

> Praktische Tipps & Tricks

VORAUSSETZUNGEN

> Sehr gute Kenntnisse in Linux

Uber 1.000 weitere Trainingsthemen finden Sie auf www.medienreich.de! 49
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FTP- und Webserver

UNIX -

mit Linux (Apache) Grundlagen — Aufbau
>< KOMPAKT KOMPAKT
1
=
; 3 Tage Kompakt-Intensiv-Training 3 Tage Kompakt-Intensiv-Training
=
= In diesem Training erhalten Sie die notwendigen Finden Sie den Einstieg in die UNIX-Welt und
Kenntnisse, um Linux mithilfe des kostenfreien lernen Sie in diesem Kurs grundlegende UNIX-
und populéren Apache-Paketes als FTP- und Funktionalitaten und -Kommandos kennen.
Webserver einzusetzen.
TRAININGSINHALTE TRAININGSINHALTE
> Installation, Konfiguration und Einfiihrung in die > EinfUhrung
verfligbaren Module (mod_ssl, mod_proxy, > Vergleich zu anderen Betriebssystemen
mod_headers, mod_rewrite etc.) > Konfiguration

> Organisation der Webprasenz > Die erste UNIX-Sitzung

> URL-Umleitung > Desktops

> Serversicherheit und Zugriffsrechte > Dateisystemeinfuhrung

> Performance-Optimierung und Hardwarekonfiguration > Editoreneinflihrung (vi)

> Protokolldateien > Regulére Ausdriicke (am Beispiel von ed und grep)

> High Availability Systems > Benutzerkommunikation (write, wall, mail, mesg)

> Load Balancing > Bourne-Shell-Einfiihrung

> Virtuelle Webserver > Korn-Shell-Einfihrung

> SSL einrichten (Secure Sockets Layer) > Bash

> Squid-Konfiguration und Squid-Firewalls > Weitere niitzliche Kommandos (find, grep, who,

> FTP-Server tr, cut, tee, wc etc.)

> Praktische Tipps & Tricks > Praktische Tipps & Tricks

VORAUSSETZUNGEN VORAUSSETZUNGEN
> Fundierte Kenntnisse im Bereich Linux und Netzwerke > Allgemeine PC-Kenntnisse
> Grundkenntnisse anderer Betriebssysteme
50 Alle Trainings bieten wir lhnen auch als individuelle Inhouse und Firmen Trainings an.



yyLas Iraining hat

mich auBerordentlich
beeindruckt und mir viele
Tipps und Tricks fur die
Webprogrammierung mit auf
den Weg gegeben bk

Foto: Patrizia Tilly@fotolia.com

Franklin Templeton Investments
XML - Grundlagen und Aufbau

»ES war die beste Schulung, die ich
seit Langem hatte. Meinen beson-
deren Dank an den Dozenten, der
mir den Stoff (ibersichtlich und ver-

stdndlich beigebracht hat.”

Biihler Technologies
TYPO3

»Die Schulung ist gut strukturiert
und die Dozentin konnte sehr gut
in-depth erklédren und lieferte fast zu
jeder Frage eine zufriedenstellende
Antwort, sehr beispielhaft.”

slugmedia GbR
HTML5

»Durch die Schulung innerhalb der
Firma konnte konkret auf aktuelle
Projekte innerhalb des Unterneh-
mens eingegangen werden und

es wurden alle Fragen umfassend
beantwortet und somit ein sehr
hoher Lerneffekt erzielt.”
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HTML -
Grundlagen — Aufbau

KOMPAKT

3 Tage Kompakt-Intensiv-Training

Lernen Sie in diesem Training fiir HTML von Grund
auf, Gestaltungselemente wie Grafiken, Tabellen
und Frames in lhre Websites einzubinden.

TRAININGSINHALTE

> Einflhrung

> Grundlagen der HTML-Programmierung
> Aufbau von HTML-Dokumenten

> Farben und Hintergrund

> Absatztypen

> Textgestaltung

> Kommentare

> Aufzéhlungen und Nummerierungen

> Interne und externe Hyperlinks

> Einbinden von Grafiken in HTML-Dokumente
> Einbinden von Tabellen

> Formatierung von Tabellen

> Ubersicht tiber die gédngigen Webbrowser
> Praktische Tipps & Tricks

VORAUSSETZUNGEN

> Allgemeine PC- oder Mac-Kenntnisse
> Internet-Grundlagen

CSS
(Cascading Style Sheets)

KOMPAKT

3 Tage Kompakt-Intensiv-Training

In diesem Training erwerben Sie die Grundkennt-
nisse fir die Stylesheet-Sprache fir strukturierte
CSS-Dokumente (Cascading Style Sheets).

TRAININGSINHALTE

> Einfliihrung in CSS

> Einsatzmdglichkeiten

> Vorteile und Grenzen

> Browserkompatibilitat

> Plattformunabhéangigkeit

> Einsatz von CSS-Editoren

> Implementieren von CSS-Vorlagen in HTML

> Selektoren und Tags

> Klassen

> Stylesheets und Formate erstellen (Schrift, Text,
Farben etc.)

> Einfache Seitenlayouts mit CSS

> Grundlagen des professionellen Designs

> Layoutregeln

> Boxmodell

> Formatierung

> Syntax

> Vererbung

> CSS und die Barrierefreiheit

> Einsatz von Floating Layouts

> Optimierung flr unterschiedliche Ausgabemedien

> EinfUhrung in komplexe Seitenlayouts

> Browserhacks

VORAUSSETZUNGEN

> Grundlegende Kenntnisse in HTML

52

Alle Trainings bieten wir lhnen auch als individuelle Inhouse und Firmen Trainings an.



Termine/Preise entnehmen Sie bitte der Trainingszeiten: @edienfelc

beigefiigten Preis- und Terminibersicht. Jeweils von 09:30 — 17:00 Uhr OMPUTERTRAININGS
JavaScript XML -
Grundlagen — Aufbau
KOMPAKT KOMPAKT e
=
3
3 Tage Kompakt-Intensiv-Training 3 Tage Kompakt-Intensiv-Training 5
Das Seminar gibt einen Uberblick tiber die M6g- Das Training richtet sich an alle, die mit der E
lichkeiten von JavaScript mit Sprachelementen, Auszeichnungssprache XML und den damit wl
Notationsregeln, Funktionen, Operatoren, verbundenen Sprachen und Werkzeugen E
Schleifen und Anweisungen. arbeiten wollen. =

TRAININGSINHALTE TRAININGSINHALTE

> Grundlagen und Aufbau von JavaScripts > EinfUhrung in XML
> Méglichkeiten und Grenzen von JavaScripts > Vergleich von HTML, XML, SGML
> Syntax von XML
Einfithrung in die strukturierte Programmierun > Aufbau von XML-Dokumenten und XML-Applikationen
9 g g > Vorstellung von XML-Editoren (XMLwriter, XML-Spy)

> Anweisungen N
> Variablen > DTD (Document Type Definition) erstellen und

einbinden
> Beispielkonstrukte fiir Listen, Verweise u. A.
> Dynamische Dokumente/Datenbankanbindung
> Formatieren mit CSS
> EinfUhrung in XSL(T)
> XML-Schemata
> Praktische Tipps & Tricks

> Operatoren
> Kontrollstrukturen
> Funktionen

Einfiihrung in die objektorientierte Programmierung
mit JavaScripts

> Objekte

> Eigenschaften

> Methoden VORAUSSETZUNGEN

Objektmodell von JavaScripts

> Vordefinierte Objekte (String, Number, ...) > HTML-Grundlagen
> Zugriff auf HTML mit JavaScripts (document, window, ...)

> Events

> Meldungsfenster

> DOM

> Dynamische Gestaltung von HTML-Seiten

> Programmierung von Formularen und der Elemente
> Cookies

> Animation von Bildern und Effekten

> Beispielanwendungen

> Praktische Tipps & Tricks

VORAUSSETZUNGEN

> Kenntnisse in HTML-Webentwicklung

Uber 1.000 weitere Trainingsthemen finden Sie auf www.medienreich.de! 53
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ASP.NET MVC 4

jQuery

KOMPAKT KOMPAKT

4 Tage Kompakt-Intensiv-Training

In diesem ASP.NET-Fortschrittstraining erlernen Sie
das Programmieren und Anwenden des neuen
ASP.NET-MVC 4 Frameworks von Microsoft.

3 Tage Kompakt-Intensiv-Training

jQuery ist eine der beliebtesten JavaScript-
Bibliotheken, die auf Websites eingesetzt
werden.

TRAININGSINHALTE TRAININGSINHALTE

> Einflhrung JavaScript

> EinfUhrung in jQuery

> Konzepte von MVC

> WCF-Webservices

> LINQ to SQL

> Entity-Framework

> Praktische Tipps & Tricks

VORAUSSETZUNGEN

> Kenntnisse in objektorientierter Programmierung in
Visual Basic .NET oder C#

> Ubersicht der Méglichkeiten von jQuery

> Kurzfassung der Neuigkeiten in HTML5 und CSS3

> Notwendige JavaScript-Kenntnisse auf die Schnelle

> Variablen, Funktionen, Kontrollstrukturen

> Webseiteninhalte suchen und das Suchergebnis
anpassen

> Seiteninhalte andern, formatieren und umgestalten

> Animationen mit jQuery

> Einfacher Einsatz von AJAX

> jQuery Ul: fertige Steuerelemente, Effekte und
Interaktionen auf Webseiten einbauen

> Rich Internet Application (RIA) erstellen mit
jQuery und jQuery Ul

> Weitere Plug-ins kennenlernen

> Einfihrung in jQuery Mobile: mobile Webseiten
einfach gemacht

VORAUSSETZUNGEN

> Grundlegende Kenntnisse in HTML und CSS
> Kenntnisse in JavaScript und DOM (von Vorteil)

54
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Schwabe Systems
FileMaker Go

»~Schulung durch einen ,Praktiker*
und somit am Zahn der Zeit. Auf
unsere individuellen Anforderungen
konnte aufgrund der kleinen Teilneh-

merzahl eingegangen werden.“

yyDie erste App-
Programmierung war ein
voller Erfolg f£

Krone GmbH
Digital Publishing fiir Tablets
oder iPads

»Individuelle Problemlésungen,
immer bereit, sehr hohes Fach-
wissen.”

Foto: minervaStudio@fotolia.com

Thomas Koch Group
WebApps mit HTMLS5 erstellen

»Durch Individualschulung konnten
relevante Themen gezielt bespro-
chen werden. Die Dozentin hatte
immer Lésungsvorschldge und
konnte diese mit mir umsetzen.”
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@edienfgich www.medienreich.com Hotline Deutschland 0800-5550116 Kostenfrei

COMPUTERTRAININGS E-Mail: info@medienreich.com Hotline Osterreich 0820-400120 € 0,12/Min.

Digital Publishing fiir Tablets EPUB mit Adobe InDesign CS6
oder iPads
s KOMPAKT KOMPAKT
=
5 2 Tage Kompakt-Intensiv-Training 2 Tage Kompakt-Intensiv-Training
E Erlernen Sie, wie Sie Inhalte fir Tablets mithilfe der Lernen Sie mit der Adobe InDesign CS6-Schulung,
[TT] Adobe Digital Publishing Suite erstellen kdnnen. elektronische Publikationen selbst zu erstellen und
— interaktive Elemente einzubinden.
)
(=]
=

TRAININGSINHALTE TRAININGSINHALTE

) Einflihrung in digitales Publizieren Interaktive Formate
> Vorstellung der verschiedenen Méglichkeiten > Animationen und Timing
und Formate > Audio- und Video-Einbindung
> Unterschied zwischen interaktiven PDFs, E-Books, > Multistatus-Objekte
Flash und E-Magazinen > Schaltflachen und Aktionen
> Erstellen einer Vorlage flr ein Tablet > Liquid Layout
> Interaktive 360°-Animationen > Flexible Textrahmen
> Diashow > alternative Layouts
> Zoomfunktion > Inhaltsaufnahmewerkzeug
> Scrollfunktionen (Smooth Scrolling) > Seitenlibergange
> InFrame-Videos
> 3D-Panorama Digital Publishing Suite und EPUB
> Interaktive Animationen und Navigationselemente > Satz und Export von E-Book-Dokumenten
> Audioeinbindung > Artikelreihenfolgen
> Praktische Tipps & Tricks > Hyperlinks

> HTML einbetten

> Diashows
VORAUSSETZUNGEN > Bildsequenzen
> Folio Producer Tools

o . > Content Viewer
> Grundlagenkenntnisse in Adobe InDesign > Overlay Creator

> Verwendung der Adobe Digital Publishing Suite > Folio Builder

VORAUSSETZUNGEN

> Grundkenntnisse in Adobe InDesign CS6

56 Alle Trainings bieten wir lhnen auch als individuelle Inhouse und Firmen Trainings an.



Termine/Preise entnehmen Sie bitte der Trainingszeiten: edienreich
beigefiigten Preis- und Terminiibersicht. Jeweils von 09:30 — 17:00 Uhr COMPUTERTRAININGS

WebApps mit HTML5 erstellen Microsoft Windows 8
Apps Entwicklung — Grundlagen

KOMPAKT KOMPAKT

Apps mit JavaScript, HTML, CSS3 und XAML.

S

—

3

3 Tage Kompakt-Intensiv-Training 3 Tage Kompakt-Intensiv-Training 5
=

Programmieren Sie lhre ersten WebApps Diese Schulung vermittelt Innen professionelles E
mit HTML5. Grundlagenwissen zur Entwicklung von Windows 8 [TT]

=

o

(=)

=

TRAININGSINHALTE TRAININGSINHALTE

> Unterschiede zwischen ,nativen Apps“ und WebApps > Einfihrung in die Architektur Windows 8 / WinRT

> Webdesign fur mobile Endgeréate > Planen und Designen einer App fur Windows 8

> HTML5, CSS3 und JavaScript fir mobile Webseiten: > Grundplanung bzgl. Navigation, Benutzerfiihrung,
eine Ubersicht der Mdglichkeiten Bedienbarkeit

> Voruberlegungen vor dem Erstellen von mobilen Seiten:
e Bildschirmauflésung
e Betriebssystem
e Benutzeranforderungen
¢ Bedienung
e | adezeiten etc.

> WebApps planen

> Praxistibungen: Audio- und Videofunktionen einbinden,
Animationen mit CSS3 und JavaScript, Offline und
LocalStorage, Geodaten auswerten und benutzen

> jQuery-Mobile- und weitere WebApp-Frameworks

Umsetzung des Layouts

> Gestalten des Ul-Layouts und deren Richtlinien fiir

> App-Leisten

> App-Einstellungen

> Suche

> Flyouts

> Meldungsdialoge

> Kontextmenis

> App-Hilfe

> Verwenden des Rastersystems firr das erweiterte Layout

einsetzen Technische Umsetzung des Layouts mit JavaScript
> Eine oder mehrere WebApps planen, entwickeln, und HTML und CSS3 bzw. C#.NET und XAML im
testen und verbessern Visual Studio 2012 im Vergleich

> WebApps in ,native Apps“ umwandeln mit PhoneGap > Auswihlen eines Layouts

> Flexibles Box-Layout

> Rasterausrichtung
VORAUSSETZUNGEN > Mehrspaltenlayout
> Bereichslayout

> Hinzufligen von Steuerelementen

> Anzeigen und Bearbeiten von Text

> Anzeigen von Bildern, Grafiken und Miniaturansichten
> Hinzufigen von Schaltflachen und Events

> Hinzufligen von Seitensteuerelementen

> Hinzufligen von Listenansichten

> Formatieren von Steuerelementen

Deklaratives Festlegen von Events mit JavaScript

Festlegen von App-Ressourcen
> Dateiressourcen
> Embedded Ressourcen

Arbeiten mit Daten und Dateien
> Datenbindung und das MVVM (Model-View-ViewModel)
Pattern

> Gute Kenntnisse in HTML und CSS
> Kenntnisse in JavaScript und ,,Mobilem Webdesign*
(von Vorteil)

Nutzen von Netzwerken und Webservices

VORAUSSETZUNGEN

> Grundlegende Programmierkenntnisse (z.B. C#.NET
oder Java)
> JavaScript-, HTML-, und CSS3-Kenntnisse sind hilfreich

Uber 1.000 weitere Trainingsthemen finden Sie auf www.medienreich.de! 57
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iPhone/iPad App-Entwicklung
(i0S 6.0)

KOMPAKT

4 Tage Kompakt-Intensiv-Training

Programmieren Sie lhre eigenen iPhone/iPad Apps!
Sie lernen u.a. die Entwicklungsumgebung XCode
und die Programmiersprache Objective-C kennen.

TRAININGSINHALTE

Die i0S-Gerdte und das Betriebssystem
> Gerate und was man beachten muss

> Welches SDK, welche Versionen gibt es?
> Informationen iPad

> Gute Apps, schlechte Apps

Objective-C Crash
> Objective-C Syntax
> Praktische Anwendung an einer App

Umgang mit XCode

> Uberblick Entwicklungsumgebung XCode
> Projektverwaltung

> Interface Builder

> Debugging

Kommunikation zwischen Oberfldche und
Programmcode

> Target Action

> MVC Pattern

> Wie nutze ich Elemente sinnvoll?

i0S Elemente und programmiertechnische Steuerung
> Textfelder, Labels, Switches etc.
> Elemente ab iOS 6.0

View-, TabBar- und Navigation-Controller in der

praktischen Anwendung

> Wie funktionieren die Controller?

> Anwendungsfalle und Apple-Vorschriften

> Praxisrelevante Beispiel-App (Customer-Management
erstellen)

TableViewController

> Einbauen und verstehen

> Beispiel-App erweitern (Kundenliste)

> Einfache Gestiken (Gestures) flr das schnelle Editieren

Internationalisierung: App mit weiteren
Sprachen erweitern

> Wie lege ich Sprachdateien an?

> Was muss ich im Programmcode beachten?

VORAUSSETZUNGEN

> Kenntnisse in objektorientierter Programmierung
in Visual Basic .NET oder C#

Android Apps entwickeln

KOMPAKT

5 Tage Kompakt-Intensiv-Training

Entwickeln Sie leistungsstarke Apps fiir Android-
Smartphones. In dieser Schulung erfahren Sie alles
Wissenswerte von der Entwicklungsumgebung tiber

die Programmierung bis zur Veréffentlichung.

TRAININGSINHALTE

> Ubersicht der Méglichkeiten von jQuery

> Kurzfassung der Neuigkeiten in HTML5 und CSS3

> Notwendige JavaScript-Kenntnisse auf die Schnelle:

> Variablen, Funktionen, Kontrollstrukturen

> Webseiteninhalte suchen und das Suchergebnis
anpassen

> Seiteninhalte andern, formatieren und umgestalten

> Animationen mit jQuery

> Einfacher Einsatz von AJAX

> jQuery Ul: Fertige Steuerelemente, Effekte und
Interaktionen auf Webseiten einbauen

> Rich Internet Application (RIA) erstellen mit
jQuery und jQuery Ul

> Weitere Plug-ins kennenlernen

> EinfUhrung in jQuery Mobile: Mobile Webseiten
einfach gemacht

> Praktische Tipps & Tricks

VORAUSSETZUNGEN

> Grundlegende Kenntnisse in HTML und CSS
> Kenntnisse in JavaScript und DOM (von Vorteil)
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yyVon der Definition bis zur
Kampagnenauswertung:
Die Inhalte des Trainings

passen perfekt zu

meinen Aufgaben &6

Foto: Yuri Arcurs@fotolia.com

Helmut KNAUS KG Campingparks
Google AdWords -
Grundlagen und Aufbau

~Sehr gute Erkldrungen, sehr genau,
auch spezifisch fir die eigene Firma,
da wir nur zwei Teilnehmer waren.

Buch zum Nachschlagen erhalten.”

DZVhA (Deutscher Zentralverein
homéopathischer Arzte)
Google Optimierung

»~Schulung war sehr individuell (In-
house-Training), eigene Webseite(n)
wurde(n) analysiert. Trainer war
souverdn, auf individuelle Fragen
wurde gut eingegangen.”

Albatross Reisen GmbH
Google Grundlagen und Aufbau

,Das Seminar wurde interessant
gestaltet, und es wurden auch viele
Beispiele genannt. Es wurde sehr
viel mit unseren eigenen Firmen
gearbeitet.”
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Google AdWords -
Grundlagen

KOMPAKT

1 Tag Kompakt-Intensiv-Training

Wir zeigen lhnen in diesem Seminar, wie Sie durch
Keyword-Advertising mit Google AdWords erfolg-
reich werben und neue Kunden gewinnen kénnen.

TRAININGSINHALTE

> Grundlagen von AdWords

> Méglichkeiten und Grenzen von AdWords

> Auswahl der richtigen Suchbegriffe

> Google-AdWords-Benutzeroberflache

> Kontoerdffnung

> Kampagnen- und Anzeigenstruktur

> Geografische und regionale Selektierung

> Anzeigentexte richtig gestalten

> Aufbau und Verwaltung des AdWords-Kontos

> Landing-Page-Optimierung

> Anzeigenrang und Klickpreise

> Werben im Google-Content-Netzwerk

> Pflege und Management von AdWords

> Kosten und Budget lhrer AdWords-Kampagne

> Conversion Tracking — den Besucher zum Kunden
machen

> Erfolgskontrolle

> Allgemeine Fragen und Probleme I6sen

> Praktische Tipps & Tricks

VORAUSSETZUNGEN

> Vorkenntnisse sind nicht erforderlich

Google AdWords -
Aufbau

KOMPAKT

1 Tag Kompakt-Intensiv-Training

Machen Sie mehr aus lhren Webkampagnen: In
diesem Seminar zeigen wir lhnen alle Tipps und Tricks
rund um das Keyword-Advertising, um den groBten
Erfolg mit Google AdWords-Werbung zu erzielen.

TRAININGSINHALTE

> Kampagnen- und Anzeigenstruktur optimieren

> Keyword-Optionen optimal nutzen

> Anzeigentexte optimieren

> Optimierung im Hinblick auf Ihre Werbeziele

> Tipps zur Steigerung der Anzeigenleistung im
Content-Netzwerk

> AdWords Editor — wie Sie offline lhre Anzeigen bearbeiten

> Display-Anzeigen im Content-Netzwerk

> Conversion-Optimierungstool

> Kampagnenstatistiken und Berichtsauswertungen —
Ziele und Wege der Auswertungen

> AdSense — wie Sie mit ihrer Website Geld verdienen

> Allgemeine Fragen und Probleme I6sen

> Praktische Tipps & Tricks

VORAUSSETZUNGEN

> Das Seminar richtet sich an Fortgeschrittene, die bereits
Google AdWords fir ihre Werbung einsetzen oder die das
Einsteigerseminar ,,Google AdWords Grundlagen® besucht
haben.
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Termine/Preise entnehmen Sie bitte der Trainingszeiten: edienfeich

beigefiigten Preis- und Terminiibersicht. Jeweils von 09:30 — 17:00 Uhr COMPUTERTRAININGS
Google Analytics - Google Optimierung
Grundlagen
KOMPAKT KOMPAKT
1 Tag Kompakt-Intensiv-Training 1 Tag Kompakt-Intensiv-Training -~
o=
<<
Erhalten Sie wertvolle Einblicke in Besucher- Wir zeigen Ihnen in diesem Seminar, wie Sie ganz E
statistiken lhres Internetauftritts und entdecken vorne bei der Google Suchmaschine mitspielen =
Sie Optimierungspotenziale. und lhre Mitbewerber hinter sich lassen. EI
(=]

TRAININGSINHALTE TRAININGSINHALTE

> Entstehung und Entwicklung der Webseitenanalyse > Wieso muss man seine Webseite fir Suchmaschinen

> Einrichtung von Google Analytics optimieren?

> Google Analytics mit Google AdWords kombinieren > Definition von Suchmaschinenoptimierung

> Websitebesucher, Besucherquellen und Content- > Wie funktionieren Suchmaschinen?
Besucherpfade analysieren > Die wichtigsten Suchmaschinen

> AdWords-Aktivitdten analysieren > Optimierung der Webseite

> Kampagnen und SEO-Reports erstellen > Suchbegriffe — wie findet man die wichtigsten und

> Conversion-Tracking mit Zielen definieren wie baut man sie am besten ein?

> Benutzerdefinierte Berichte erstellen > Strukturierungen der Webseite

> E-Commerce und Google Analytics > Optimierung des Inhalts

> Praktische Tipps & Tricks > Verlinkung

> So landen Sie langfristig auf den vordersten Platzen

> Erfolge messen
VORAUSSETZUNGEN > Nicht aufhéren, wenn man oben angekommen ist
> Was man nicht tun sollte

> Praktische Tipps & Tricks

VORAUSSETZUNGEN

> PC-Grundlagenkenntnisse, Internet-Grundkenntnisse

> Windows- und Internet-Grundkenntnisse

Uber 1.000 weitere Trainingsthemen finden Sie auf www.medienreich.de! 61



Q@edienreich

COMPUTERTRAININGS

www.medienreich.com
E-Mail: info@medienreich.com

Hotline Deutschland 0800-5550116 kostenfrei
Hotline Osterreich 0820-400120 € 0,12/Min.

S
=
[
L
<
o
<t
=
[T}
=
=
—
(=)

Google Optimierung -
Fiir Programmierer

KOMPAKT

1 Tag Kompakt-Intensiv-Training

In diesem Training erfahren Sie, worauf Such-
maschinen wie Google, Yahoo & Co. Wert legen
und wie ein HTML-Dokument optimalerweise
aufbereitet werden sollte.

TRAININGSINHALTE

> Allgemeine Ziele der Suchmaschinenoptimierung

> Funktionieren der Suchmaschinen (Crawling,
Auswerten, Bewerten)

> Ziele fir einzelne Dokumente definieren (Was und wen
mdchte ich erreichen?)

> Bedeutung von Keywords und Optimierung eines
HTML-Dokumentes bezlglich dieser Keywords

> Umfeld- und Mitbewerber-Seiten: Differenzieren
statt Kopieren

> Aufbau von Webseiten (anhand einer kleinen
Beispiel-Webseite)

> Bedeutung der HTML-Tags (Formatierungsbefehle)
und sinnvolle Verwendung

> Bedeutung des Head-Bereiches eines HTML-Dokumentes

> Einsatz von CSS

> Wert von Text gegenlber Bildern und Flash-Animationen

> Bedeutung und Nutzung von Verzeichnis- und
Dateinamen

> Was man vermeiden sollte, ,,verbotene*
Optimierungsmethoden

> Links, Backlinks, Google PageRank

> Einblick in Erfolgskontrolle mit Google Webmaster-Tools
und Google Analytics

> Praktische Tipps & Tricks

VORAUSSETZUNGEN

> Grundlagen HTML
> Grundlagen CSS (Cascading Style Sheets)

Onlinemarketing

KOMPAKT

1 Tag Kompakt-Intensiv-Training

In diesem Seminar lernen Sie von der Zieldefinition
und Planung lber die Realisierung bis zur
Kampagnenauswertung und -optimierung alles
fiur ein erfolgreiches Web-Marketing.

TRAININGSINHALTE

> Grundlagen des Onlinemarketings
> Auswahl der richtigen Werbemittel
> Konzeption eines erfolgreichen Konditionsmodells
> Anbieter und Kosten

> Netzwerke und Partnerprogramme
> Keyword-Advertising

> Grundlagen Affiliate-Marketing

> Bannerwerbung und Portale

> Newsletter

> Web-2.0-Nutzungsmdéglichkeiten

> Guerillawerbung

> Betrug und Probleme

> Tracking-Server

> Erfolgskontrolle

> Praktische Tipps & Tricks

VORAUSSETZUNGEN

> Dieser Kurs ist fur alle Interessenten geeignet.
Bestimmte Vorkenntnisse sind nicht erforderlich.
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ESA Elektroschaltanlagen Grimma
Social Media Marketing

»Kleine Schulungsgruppe mit hohem
Lernerfolg, kompetenter Dozent und
viel Schulungsmaterial. Super! “

yyUas Training hat uns die
vielen Chancen des Social
Media Marketings fur unser
Unternenmen anschaulich
aufgezeigt b6

Foto: chagin@fotolia.com

Tanja Lemann
Workshop

»Der Trainer ist ein duBerst kompe-
tenter, einfiihisamer, hilfsbereiter
und geduldiger Mensch, der flexibel
und kompetent auf meine Fragen
einging, das Ziel nicht aus den
Augen verlor und menschlich sowie
fachlich sehr kompetent ist und den
Kern der Sache erfasst hat.“

Bergmann & Partner
Workshop

»~Was war gut: die Flexibilitdt beim
Buchen des Trainings, die unkom-
plizierte Art des Organisators und
des Trainers.”
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Social Media Marketing -
Der Einstieg

KOMPAKT

Social Media Monitoring

KOMPAKT

=
(=]
m - - - - - -
= 2 Tage Kompakt-Intensiv-Training 1 Tag Kompakt-Intensiv-Training
—
=
8 Das Seminar gibt eine Einfiihrung in Kunden- Lernen Sie in unserer Social Media Monitoring
(77) kommunikation, Unternehmensprasentation Schulung den erfolgreichen Einsatz dieser
und Werbung in den sozialen Netzwerken, Analysemethode kennen.
Communities und Blogs im Internet.
TRAININGSINHALTE TRAININGSINHALTE
> Social Media — was ist das? > Definition: Social Media Monitoring
> Was kann Social Media? > Grundbegriffe, Ansatz, Prozesse
> Was bengtige ich fir Social Media? > Vorstellung relevanter Foren, Weblogs und
> Vorstellung der wichtigsten Social Media Netzwerke: Social Media Plattformen
e Facebook, Google+, XING, LinkedIn, Twitter, u.a. > Wie setzt ein Unternehmen Social Media Monitoring
> Basiswissen in Strategiefindung fiir Social Media erfolgreich ein?
> Zielgruppenfindung > In welchen Bereichen wird Social Media Monitoring
> Grundkenntnisse in Bedarfs- und Zielanalyse eingesetzt?
> Uberblick der Werbeformen (z. B. Facebook Ads, > Wie kann eine Strategie aussehen, um Monitoring
YouTube-Channel-Werbung etc.) erfolgreich umzusetzen?
> Unternehmensbezogene Dienste > Welche Analyseformen gibt es?
(z.B. XING-Unternehmensgruppen, etc.} > Vor- und Nachteile
> Messen Sie |hren Erfolg mit Social Media Monitoring > Tipps zur richtigen Auswahl der Monitoring Tools
> Social Media Guidelines > Bewertung der Datenqualitat
> Relevante Kennzahlen > Leistungskennzahlen im Social Media Reporting
> Social Media im Unternehmen integrieren > Hilfestellung zur Findung der richtigen Anbieter
> Kommunikationsformen (Vergleich, Bewertung, Anforderung)
> Werbeformen > Praktische Tipps & Tricks
> Fragerunde
> Haufige Fehler
> Praktische Tipps & Tricks Vo RAUSSETZUNGEN
VORAUSSETZUNGEN > Internet-Kenntnisse
> PC- und Internet-Grundkenntnisse
64 Alle Trainings bieten wir Ihnen auch als individuelle Inhouse und Firmen Trainings an.



Termine/Preise entnehmen Sie bitte der Trainingszeiten: &@E’diE’ﬂfE’lCh

beigefiigten Preis- und Terminibersicht. Jeweils von 09:30 — 17:00 Uhr

Facebookmarketing — Google+
Fiir Entscheider
KOMPAKT KOMPAKT <
=
1 Tag Kompakt-Intensiv-Training 1 Tag Kompakt-Intensiv-Training =
-
I
Erfahren Sie in unserer Facebookmarketing Optimieren Sie lhre Kundenkommunikation mit- 8
Schulung, wie Sie diese Plattform fiir lhr hilfe von Google+. In diesem Seminar lernen (7
Unternehmen nutzen kénnen. Sie bewahrte Vorgehensweisen kennen.

TRAININGSINHALTE TRAININGSINHALTE

> Vorstellung der wichtigsten Informationen liber Facebook > Willkommen in der Google-Welt

> Nutzeranzahl > Uberblick von Google+-Funktionen

> Wie wird Facebook genutzt? > Google+ und Facebook

> Grundlagen und Einflihrung > Welche Kosten kommen auf mich zu?

> Zusammenspiel von Facebook und Social Media > Einrichten eines Google+-Profils inkl. Foto,

> Was sind Social Media Guidelines? Fotowand, Beitrage etc.

> Wie vernetze ich mich? > Erklarung der Kreise, Hangouts, Places

> Was sind die Funktionen von Facebook? > Verknlpfung mit verschiedenen Webseiten

> Welche unterschiedlichen Seiten gibt es? > Einrichtung und Administration einer

> Wie baue ich eine Unternehmensseite (Page) auf? Google+-Unternehmensseite

> Erarbeitung der Strategie und Themen > Was sind gute Google+-Webseiten?

> Welche Inhalte werden gepostet? > Wie kommuniziere ich mit Google+?

> Wie gehe ich mit Kommentaren, Statuszeile etc. um? > Wie optimiere ich die interne und externe Kommunikation?
> Anwendungen in Facebook > Erklarung des +1-Button, Google Badges und RSS-Feed
> Werbeformate (z. B. Facebook Ads) > Google+-Auswirkung auf die Suchmaschinenoptimierung
> Zielgruppenfindung > +1-Aktivitaten interpretieren

> Auswertungen und Kennzahlen > Ubersicht der Google Webmaster Tools

> Like-Buttons > Praktische Tipps & Tricks

> Praktische Ubungen

Praktische Tipps & Tricks
> Prakt PP VORAUSSETZUNGEN
VORAUSSETZUNGEN > Keine

> Internet-Kenntnisse

Uber 1.000 weitere Trainingsthemen finden Sie auf www.medienreich.de! 65



CGedienreid

www.medienreich.com
E-Mail: info@medienreich.com

Hotline Deutschland 0800-5550116 kostenfrei
Hotline Osterreich 0820-400120 € 0,12/Min.

Google+ Local - Fiir Unternehmen

Online Reputationsmanagement

< KOMPAKT KOMPAKT
=
m - - - - - -
= 1 Tag Kompakt-Intensiv-Training 1 Tag Kompakt-Intensiv-Training
—
=
8 Erfahren Sie alles Giber Google+ Local (ehemals Die Schulung Online Reputationsmanagement
177} Google Places), um lhrem Unternehmen noch vermittelt die wichtigsten Kenntnisse, um
mehr Schwung zu verleihen. digitale Identitaten prifen und gezielt
beeinflussen zu kénnen.
TRAININGSINHALTE TRAININGSINHALTE
> Einflhrung in den Google-Dienst Google+ Local > Reputationsmanagement 2.0
> Grlinde fur den Einsatz von Google+ Local > Grundlagen und Begriffserklarungen
> Kontoerstellung in Google+ Local > Bedeutsamkeit der digitalen Identitat
> Optimierung eines Unternehmenskontos > Gutes Ansehen — aber wie?
> Ranking-Faktoren > Welche Spuren hinterlasse ich?
> Google+ Local Dashboard > Wie kann ich mich schiitzen?
> Verwaltung von Erfahrungsberichten > Strategien zum Selbstmarketing
> Verwaltung von Sperrfunktionen > Vorstellung von Social Media Portalen
> Praktische Tipps & Tricks und Webdiensten
> Communitys und Multiplikatoren
> Online-Talks
VORAUSSETZUNGEN > Reputationsmonitoring
> Trends
> Internet-Kenntnisse > Wettbewerbsanalyse
VORAUSSETZUNGEN
> Internet-Kenntnisse
66 Alle Trainings bieten wir lhnen auch als individuelle Inhouse und Firmen Trainings an.



yyDank der interessanten
Ubungen kann ich
jetzt die Website selbst
administrieren &

Foto: rido@fotolia.com

DFB-Medien
TYPOS3 - Fiir Redakteure

»,War gut organisiert und informativ.”

Biihler Technologies
TYPO3

,Veranstalter war sehr flexibel.
Seminarleiter ist auf Fragen und
persénliche Wiinsche eingegangen.
Seminarunterlagen sind ausreichend
im Preis inbegriffen. Alles in allem
kann man sehr zufrieden sein. “

FAIST ChemTec GmbH
Joomla! - Fiir Entwickler und
Administratoren

»Mir hat das komplette Seminar sehr
gefallen. Es konnte auf alle benétigten
Themengebiete eingegangen und alle
Fragen beantwortet werden. Es hat
nicht nur viel SpaBB gemacht, sondern
war auch sehr lehrreich.”
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TYPO3 - Fiir Redakteure Drupal - Fiir Redakteure
W KOMPAKT KOMPAKT
=
o
g 2 Tage Kompakt-Intensiv-Training 2 Tage Kompakt-Intensiv-Training
o
% Dieses Seminar richtet sich an Redakteure, die Das Training widmet sich dem Open-Source-
(7 mit dem bekannten Open-Source-Content- Content-Management-System Drupal aus
o3 Management-System (CMS) TYPO3 arbeiten. Redaktionssicht und vermittelt grundlegende
g Fahigkeiten fur die Veroffentlichung von Inhalten.
(&

TRAININGSINHALTE TRAININGSINHALTE

> TYPOS3-Einfiihrung > EinfUhrung in Drupal

> Benutzeroberflache und TYPO3-Module > Benutzeroberflache

> Standard-Seitentypen > Themes und Templates

> Neue Seiten anlegen und bearbeiten > Texteditor

> Neue Inhalte anlegen und bearbeiten > Kategorien und Inhalt

> Rich Text Editor > Navigationsmenu

> NavigationsmenU > Tabellen

> Tabellen und Formulare > Formulare

> Newsletter, Foren und FAQ > Downloads bereitstellen

> Downloads bereitstellen > Verodffentlichung

> Passwortgeschtzte Bereiche > Newsfeeds

> Rechtemanagement > Erweiterungen: Webblog, Forum, Fotogalerie
> Veréffentlichung > RSS-Feeds

> Workspaces > Mehrsprachigkeit

> Versionierung > Drupal im Team

> TYPO3 im Team > Suchmaschinenoptimierung
> Suchmaschinenoptimierung > Barrierefreiheit

> Barrierefreiheit > Praktische Tipps & Tricks

> Praktische Tipps & Tricks

VORAUSSETZUNGEN
VORAUSSETZUNGEN

> Aligemeine PC-Kenntnisse
> Aligemeine PC-Kenntnisse > Allgemeine Internet-Kenntnisse
> Allgemeine Internet-Kenntnisse
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Termine/Preise entnehmen Sie bitte der Trainingszeiten:

beigefiigten Preis- und Terminibersicht. Jeweils von 09:30 — 17:00 Uhr

Magento - Fiir Entwickler Joomla! - Fiir Anwender
KOMPAKT KOMPAKT L
=
o
5 Tage Kompakt-Intensiv-Training 2 Tage Kompakt-Intensiv-Training g
o
Entwickeln Sie eigene Erweiterungen fiir das Dieses Seminar richtet sich speziell an Redakteure, %
verbreitete Shopsystem Magento. die mit dem Open-Source-Content-Management- (7
System (CMS) Joomla! arbeiten. o
(72}
=
(&

TRAININGSINHALTE TRAININGSINHALTE

> Einflhrung in die Magento Entwicklung von Modulen > EinfUhrung in Joomla!

> Erlauterung der Architektur von Magento > Benutzeroberflache

> Kurzer Uberblick Zend-Framework > Neue Seiten anlegen und bearbeiten

> Magento und die Verwendung von Model View > Neue Inhalte anlegen und bearbeiten
Controller (MVC) > Texteditor

> Wie ist ein Modul aufgebaut? > Templates

> Was ist die Struktur eines Moduls? > NavigationsmenU

> Konfiguration von Modulen > Tabellen

> Magento Module installieren > Formulare

> Magento Controller > Newsletter

> Magento Template Engine > Foren und FAQ

> Magento Frontend bearbeiten > Downloads bereitstellen

> Entwicklung eines eigenen Designs (Themes, > Passwortgeschiitzte Bereiche
Designpaket) > Verodffentlichung

> CSS-Nutzung und Magento > Mehrsprachigkeit

> Vorstellung beliebter Module (z. B. Commerce Bug, > Joomla! im Team
FireGento etc.) > Suchmaschinenoptimierung

> Magento Community > Barrierefreiheit

> Praktische Tipps & Tricks > Praktische Tipps & Tricks

VORAUSSETZUNGEN VORAUSSETZUNGEN
> Objektorientierte Programmierung mit PHP > Aligemeine PC-Kenntnisse

> Allgemeine Internet-Kenntnisse

Uber 1.000 weitere Trainingsthemen finden Sie auf www.medienreich.de! 69
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WordPress - Fiir Anwender

KOMPAKT

2 Tage Kompakt-Intensiv-Training

Erstellen Sie professionell lhren eigenen Blog
mithilfe von WordPress.

TRAININGSINHALTE

> Einstieg in WordPress

> Artikel erstellen

> Artikel bearbeiten

> Kategorien definieren

> Bilder einfligen

> Unterseiten erstellen

> Beitrage verwalten

> Import und Export

> Externe Inhalte einbinden
> Kommentarfunktion

> Links

> Design-Themes anwenden
> Mediathek anwenden

> Blog erstellen

> Suchmaschinenoptimierung
> WordPress als CMS

> Praktische Tipps & Tricks

VORAUSSETZUNGEN

> Grundlagen in einem gangigen Browser
(z.B. Mozilla Firefox, Internet Explorer etc.)
> Grundlagenkenntnisse in der Textverarbeitung

Shopware - Fiir Anwender

KOMPAKT

2 Tage Kompakt-Intensiv-Training

Durch unsere Schulung lernen Sie, lhren
Webshop professionell zu verwalten.

TRAININGSINHALTE

> Vorstellung der Benutzeroberflache von Shopware
> Vorstellung der einzelnen Funktionen
> Konfiguration der Grundeinstellungen

Verwaltung von:

> Firmendaten

> Artikeln

> Kategorien

> Kunden

> Zahlungsweisen, Wéhrungen und Steuerinformationen
> Versand

> Sprachen

> Bildern

> Suchmaschinenoptimierung

> Optimierung des Shopware-Shops
> Praktische Tipps & Tricks

VORAUSSETZUNGEN

> Internet-Kenntnisse
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Seleon
Microsoft Exchange Server

»Inhaltlich war die Schulung sehr
nahe an dem Echtbetrieb orientiert.
Sinnvolle Auswahl der Themen; sehr
gut erldutert.”

yy Der praxisorientierte
Kurs hat uns dabei
senr unterstutzt, in
unserem Unternehmen
ein modernes Intranet
einzurichten &k

acentic GmbH
Grundlagen Netzwerktechnik

»Der Unterrichtsstil war gut. Der
Dozent war vorbereitet, hatte die
notwendigen Kenntnisse und ist auf
Fragen eingegangen. Die Méglich-

keit, Verstdndnisfragen bei diesem
Grundlagenkurs zu stellen, war
gegeben und fand ich sehr gut! Das
Tempo im Vorgehen des Unterrichts
war gut abgestimmt mit den prak-
tischen Ubungen.“

Foto: Kurhan@fotolia.com

Landesmuseum Koblenz
Workshop

»Sehr anschauliche Ubungen, die
man bei der tédglichen Arbeit bens-
tigt. Kompetent und versténdlich
erklart auch im Hinblick auf kleine
Tricks und Kniffe.“
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Microsoft SQL Server
Administration — Fortschritt

KOMPAKT

3 Tage Kompakt-Intensiv-Training

Erweiten Sie Ihre Kenntnisse in der
Administration von SQL-Servern.

TRAININGSINHALTE

> Inhalte aus dem Microsoft SQL Server Administration —
Grundlagenseminar Gbernehmen

> Verwalten und Verteilen von Datenbanken

> Datenbankobjekte: Schemaverwaltung fur Tabellen,
Views/Sichten, Prozeduren und Funktionen

> Ubertragen und Importieren von Daten in/aus
Microsoft Office / Oracle / SQL-Server etc.

> Einfuhrung in Replikationen

> Leistungsoptimierung

> Uberblick Dienste (Analysis, Integration und
Reporting Services)

> Praktische Tipps & Tricks

VORAUSSETZUNGEN

> Microsoft SQL Server Administration — Grundlagen

VMware ESX

KOMPAKT

3 Tage Kompakt-Intensiv-Training

Der Kurs vermittelt Ihnen die wichtigsten
Grundlagen zum VMware ESX Server.

TRAININGSINHALTE

> Architektur des VMware ESX Server

> Zugriffswege auf den VMware ESX 3 Server
> VMware ESX-Kommandos

> VMX-Parameter

> Datei- und Verzeichnisstruktur

> Konfigurations-Dateien und Protokolldateien
> Verzeichnisstruktur des VMKernels

> VirtualCenter

> Install- und Bootparameter (Anaconda und GRUB)
> Kickstart

> Sicherheit, Uberwachung, Protokollierung

> Root-Zugriff, Benutzerverwaltung

> Firewall, SSL-Zertifikat

> Aktualisierung, Patch-Management

> Sicherung, Disaster Recovery und Klonen

> VMware Infrastructure Toolkit

> Installation und Konfiguration

> Remote CLI

> Installation

> Common VI Options

> Hostsystem, VMware Server 2 fiir Windows und Linux
> Gastsysteme

> Migration und Import virtueller Maschinen

> Virtuelle Netzwerke

> Optimierung und Tuning

> VMware Scripting

> Praktische Tipps & Tricks

VORAUSSETZUNGEN

> Gute bis sehr gute Linux-Kenntnisse
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Siemens
PC-Grundlagenschulung

»~Was war gut: auf den Kunden gut
eingegangen.*

,,Ich fUhle mich beim Surfen

Im Internet nun wertaus
sicherer und nutze das
Internet zielgerichteter als
vorher ki

Foto: rido@fotolia.com

Amadeus GmbH
Internetrecht

»Die Kompetenz und Héflichkeit
des Dozenten war hervorragend. Es
wurde direkt auf unsere Wiinsche
und Bedlrfnisse eingegangen, vor
allem im Hinblick auf die tatsdch-
liche Arbeitssituation, die wir zu
bewdltigen haben.”

Concept
Cloud Computing fiir
Unternehmen

»Verstdndliche Erkldrung, auf Fragen
wurde sehr genau eingegangen und
umfangreich geantwortet. Lockere
Atmosphére, zum Lernen genau
richtig!!!“
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Internet — Basiswissen

KOMPAKT

2 Tage Kompakt-Intensiv-Training

Wie Sie die unzahligen Moglichkeiten des World
Wide Web muhelos fur lhre Zwecke nutzen,
lernen Sie in diesem Seminar.

TRAININGSINHALTE

> Basiswissen

> Einfuhrung in das Internet

> Zugang zum Internet

> Funktionsweise des Internets

> Arbeiten mit dem Internet Explorer
> Praktische Techniken

> Webseiten offline

> Outlook Express

> Downloads

> Suchmaschinen

> Daten aus dem Internet laden

> FTP mit dem Internet Explorer

> Vergleich unterschiedlicher Browser
> Online-Bibliotheken nutzen

> Benutzerdefinierte Suche im Internet
> Grundlagen des E-Commerce

> Konfiguration des Internet Explorers
> Sicherheit im Internet

> Daten schitzen

> Firewalls

> Virenprogramme

> Praktische Tipps & Tricks

VORAUSSETZUNGEN

> Microsoft SQL Server Administration — Grundlagen

PC — Basiswissen

KOMPAKT

2 Tage Kompakt-Intensiv-Training

In diesem Kurs erwerben Sie die erforderlichen
Grundkenntnisse fiir den Umgang mit dem PC.

TRAININGSINHALTE

> Datenverarbeitung mit dem Computer

> Der Computer und seine Hardware

> Betriebssysteme

> Windows

> Anwendungen unter Office

> Datenschutz und Datensicherheit

> Ordner- und Dateinamen

> Grundlagen fur Textgestaltung

> Formatierungen

> E-Mails

> Kontakte

> Tabellenaufbau (Struktur, Eingabe, Korrektur)

> Funktionen

> Export zu anderen Anwendungen (Word, PowerPoint)

> Vorgehen bei Présentationen

> Texteingabe, Tabellen, Diagramme

> Sicherheit (Viren, Dialer, Trojaner etc.)

> Effektive Recherche im Internet (verschiedene
Suchmaschinen)

> Ubertragungstechniken/Netzwerke (LAN, WLAN,
Bluetooth etc.)

> Datenaustausch (PDA, Handy etc.)

> Praktische Tipps & Tricks

VORAUSSETZUNGEN

> Keine
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Norma
Datenschutzrecht

»~Sehr gut hat mir gefallen, dass
sofort auf Fragen reagiert wurde und
diese gleich geklart wurden. Auch

nicht im Plan enthaltene Themen
wurden nach Bedarf erklart. Die
Schulung wurde sehr gut auf die
Teilnehmer und ihre Probleme
angepasst.”

yyoelbst komplexe
Informationen wurden
bestens erlautert &6

Foto: minervaStudio@fotolia.com

Victor Renz GmbH
Juristische Voraussetzungen
fiir Webdesigner

»Verstdndliche, unkomplizierte, kom-
petente Dozentin, die die teils kom-
plexen Inhalte anschaulich erkldren
konnte.”

Accony GmbH
Datenschutzrecht -
Basiswissen

»Der Trainer war spitze. Geduldig
und unterhaltend hat er anspruchs-
voll den vielen Stoff vermittelt. Es
hat groBe Freude bereitet.”




@edienrelch www.medienreich.com Hotline Deutschland 0800-5550116 kostenfrei
e’ COMPUTERTRAININGS E-Mail: info@medienreich.com Hotline Osterreich 0820-400120 € 0,12/Min.
Datenschutzrecht — Basiswissen Juristische Voraussetzungen fiir

sicheres Cloud Computing

KOMPAKT KOMPAKT

=
= =
e
oc 1 Tag Kompakt-Intensiv-Training 1 Tag Kompakt-Intensiv-Training
[
Hier erhalten Sie einen kompakten Uberblick tiber Rechtliche Informationen Giber Cloud Computing -
rechtliche Aspekte zum Thema Datenschutz. kompakt und leicht verstandlich erklart.
TRAININGSINHALTE TRAININGSINHALTE
> Einflhrung/Grundlagen > Grundlagen/Beispiele
> Begriffe/Definitionen > Cloud-Formen
> Grundsatze > Cloud-Dienstleistungen
> Einschlagige Gesetze > Einschlagige Rechtsgebiete
> E-Mail-Marketing (Spam-Problematik) > Zivilrechtliche Grundlagen
> Social Plug-ins (,,2-Klick-Losung®) > IT-Vertragsrecht
> Analyse-Software (Erhebung von IP-Adressen) > Compliance
> Cookies > Datenschutzrecht
> Datenschutzerklarung flir Websites/Webshops > Strafrecht (§ 203 StGB)
> Datenschutzbeauftragter > Urheberrecht
> Praktische Tipps & Tricks > Recht am eigenen Bild
> Praxistipps/Checklisten
> Praktische Tipps & Tricks
VORAUSSETZUNGEN
> Kein juristisches Vorwissen nétig VORAUSSETZUNGEN
> Allgemeine Internet-Kenntnisse
> Kein juristisches Vorwissen nétig
76 Alle Trainings bieten wir Ihnen auch als individuelle Inhouse und Firmen Trainings an.



ProLogis
Zeitmanagement

~Was war gut: Selbstfindung und
Erkenntnis, Zeitmanagement hat
nicht unbedingt etwas mit Zeit zu

tun.”

yy Die Schulung war
individuell auf mein
Tatigkeitsfeld ausgerichtet
und hilft mir, den
Arbeitsalitag effizienter
7U gestalten &6

Degewo
Forderungsmanagement GmbH
Workshop

»Der Trainer hat das prima gemacht,
ruhig, strukturiert, und hat durch gute
Ubungsbeispiele den Stoff verfestigt
und die Teilnehmer eingebunden.”

Foto: pressmaster@fotolia.com

ACS GmbH
Workshop

»Klar strukturiertes Programm des
Dozenten, trotzdem war immer Zeit,
Fragen ,drumherum* zu stellen und
Antworten zu bekommen.“
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Kundenorientierte Briefe und E-Mails

KOMPAKT

2 Tage Kompakt-Intensiv-Training

In diesem Training erwerben Sie die sprachliche und
formale Sicherheit fiir die tagliche Korrespondenz
in E-Mails und Geschaftsbriefen.

TRAININGSINHALTE

> Neue Trends in der Kundenkorrespondenz

> Serviceorientierung in der geschéftlichen Korrespondenz

> Sach- und Beziehungsebene in der Korrespondenz

> Formale Tipps zur Brief- und E-Mail-Gestaltung

> Rechtschreibung und Grammatik

> Briefe und E-Mails stilsicher verfassen

> Optisch ansprechende Briefe und E-Mails

> Schreibhemmungen abbauen

> Zahlungserinnerungen und Mahnungen
kundenfreundlich formulieren

> Kundenbeschwerden und Reklamationen
professionell beantworten

> Die wichtigsten Regeln fir E-Mails

> Corporate Wording

> Werbebriefe

> Mustertexte

> Praktische Tipps & Tricks

VORAUSSETZUNGEN

> Keine

Prasentationstraining

KOMPAKT

2 Tage Kompakt-Intensiv-Training

Lernen Sie das effektive Vorbereiten und
Durchfuhren lhrer Prasentationen.

TRAININGSINHALTE

> Visualisierung

> Medienwahl

> Verwendung von Pinnwand und Flipchart
> Zielgruppenanalyse

> Vorgehensweisen zur Stoffsammlung

> Kdrpersprache

> Aufbau und Dramaturgie der Prasentation
> Rhetorik

> Der gelungene Einstieg

> Mit Lampenfieber umgehen

> Wie gehe ich mit Einwéanden, Fragen um?
> Kommunikationstraining

VORAUSSETZUNGEN

> Keine
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yyDie Schulung hat mir
anhand vieler Ubungen
gezeigt, wie ich Gesprache
richtig aufbaue und fihre &k

Foto: shock@fotolia.com

JjSERVICE GmbH
Zeitmanagement

»~Auf Fragen der Teilnehmer wurde
sehr gut eingegangen. Catering war
auch gut.”

HAVG Rechenzentrum
Zeitmanagement

»,Die Atmosphére war locker und
stressfrei. Der Inhalt konnte an Bei-
spielen sehr gut erldutert werden.”
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ProLogis
Zeitmanagement

,Bin sehr zufrieden und habe viel
gelernt. Gute praxisbezogene
Schulung mit prézisen Erkldrungen.
Meine Erwartungen wurden erfillt! “



@gdienreicﬁ
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Konfliktmanagement

KOMPAKT

2 Tage Kompakt-Intensiv-Training

In diesem Seminar lernen Sie, Konflikten pro-
fessionell zu begegnen und die Beziehungen im
Unternehmen oder zu Geschéftspartnern nach-

haltig zu stabilisieren und zu verbessern.

TRAININGSINHALTE

> Konfliktursachen

> Bestehende und entstehende Konflikte
> Analyse der Erwartungshaltung

> Beziehungsgestaltung

> Umgang mit Konflikten

> Streitkultur

> Bedurfnisse und Interessen

> Verbale und nonverbale Kommunikation
> Strategien zur Konfliktvermeidung

> Typische betriebliche Probleme

> Konfliktgesprache vorbereiten und flihren
> Praktische Tipps & Tricks

VORAUSSETZUNGEN

> Keine

Zeitmanagement

KOMPAKT

2 Tage Kompakt-Intensiv-Training

In diesem praxisnahen Kurs erlernen Sie sinnvolle
Lésungen und Techniken, lhre Zeit effektiv zu
planen und Stresssituationen souveran zu
begegnen.

TRAININGSINHALTE

> Grundprinzipien fur effektives Zeitmanagement

> Ebenen des Zeitmanagements

> Zeitprotokoll und Zeitdisziplin

> Psychologische Faktoren fiir das individuelle
Zeitverhalten

> Tagesplan, Leistungskurve und Prioritaten

> Psychologische Antreiber

> Zeitfresser

> Lernen Sie, ,Zeitdieben” (zu viele E-Mails und Telefon-
anrufe) besser entgegenzutreten und lhre Tages-
Aktivitaten nach Prioritdten optimal zu strukturieren

> Stressfaktoren

> Organisationsfehler

> Arbeitsplatz, Schreibtisch, Ablage

> Praktikabler Softwareeinsatz

> PC-Organisation

> E-Mails effizient nutzen und ablegen

> Analyse des eigenen Tagesablaufs

> Praktische Tipps & Tricks

VORAUSSETZUNGEN

> Keine
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Gerne erstellen wir Ihnen ein individuelles Trainingsangebot

Alle Computerkurse und Schulungen aus unserem Trainingsangebot sowie viele weitere Themen
bieten wir Ihnen auch als individuelle Trainings an.

Nutzen Sie die Vorteile eines individuellen Trainings:

[ Inhouse Training
> Wir kommen zu lhnen.
> Sie bestimmen den Schulungstermin.
> Schulungsschwerpunkte kénnen individuell aus
unserem Trainingsprogramm gewahlt werden.
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[0 Firmen Training
> Sie kommen zu uns.
> Individuelle Schulungstermine sind méglich.
> Schulungsschwerpunkte kénnen individuell aus
unserem Trainingsprogramm gewahlt werden.

Firma:

Anrede: [ Herr {4 Frau
Vorname/Nachname:
Telefon:

E-Mail:

Welches Thema und welche
Inhalte sollen geschult werden?:

Teilnehmerzabhl (falls schon bekannt):
lhr Terminwunsch:

Trainingsort:

BITTE SCHICKEN SIE IHRE ANFRAGE AN: +49 521 968774-90 (FAX)

Wir beraten Sie gerne unter 0800 - 5550116 (kostenfreie Beratungshotline) 81



@edienreich

COMPUTERTRAININGS

Anmeldung

Fax: +49 521 96877-490 oder senden an:

Training:
Thema:
Software/Version:
Termin:
Schulungsort:
Teilnehmer:
Teilnehmeranzahl:

Teilnehmername/n:

medienreich Training GmbH
Hermannstr. 3
33602 Bielefeld

Rechnungsanschrift:

Firma:

Anrede:

Vorname:

StraBe / Nr.:

PLZ / Ort:

Land:

Telefon:

E-Mail:

U Herr U4 Frau

Abteilung:

Nachname:

Fax:

Ansprechpal‘tner/in fi.'ll‘ eventue"e RGCkfragen: (falls abweichend von der Rechnungsanschrift)

Anrede:

Vorname:

Telefon:

E-Mail:
Unterschrift:

Ort / Datum:

U Herr 4 Frau

Nachname:

Fax:

Unterschrift:

82 Wir beraten Sie gerne unter 0 800 - 5550 116 (kostenfreie Beratungshotline)

bitte hier heraustrennen




Allgemeine Geschaftsbedingungen
Stand: Juli 2017

Die medienreich Training GmbH, vertreten durch den Geschéftsfiihrer Herrn Frank Schmittat,
Hermannstr. 3, 33602 Bielefeld, Fax:+ 49 (0) 521-968774-90, E-Mail: info@medienreich.com, wird im
folgenden MT genannt.

§1 Allgemeines

Diese allgemeinen Geschftsbedingungen (AGB) stellen die Grundlage fiir die Nutzung der Services
der MT dar und regeln die vertraglichen Beziehungen zwischen MT und dem Kunden (im Folgenden
auch Nutzer, Benutzer, Besteller oder Anwender genannt). Wenn und soweit es fiir Produkte gesonderte
Lizenzvereinbarungen gibt (so z.B. Softwarelizenzvertrdge bzw. AGB von Drittanbietern etc.), so gelten
diese ergdnzend. Die allgemeinen Geschaftsbedingungen von MT gelten ausschlieBlich; entgegenste-
hende oder von unseren Geschéftsbedingungen abweichende Bedingungen des Kunden werden nicht
anerkannt, es sei denn, es wurde ausdricklich schriftlich ihrer Geltung zugestimmt. Die allgemeinen
Geschéaftsbedingungen von MT gelten auch dann, wenn in Kenntnis entgegenstehender oder von den
MT-Geschaftsbedingungen abweichende Bedingungen des Kunden die Dienstleistung bei dem Kunden
vorbehaltlos ausgefihrt wird.

Leistungen von MT erfolgen ausschlieBlich auf der Grundlage dieser AGB in ihrer zum Zeitpunkt der
Nutzung jeweils gltigen Fassung. Abweichende Regelungen haben nur dann Geltung, wenn sie zwischen
den Parteien schriftlich vereinbart worden sind. Dieses Schriftformerfordernis gilt auch fir die Abbedin-
gung der Schriftform.

§2. Vertragsgegenstand und Leistungskatalog

2.1. Gegenstand des Vertrages ist die Organisation und Durchfiihrung von Schulungen. Der Inhalt der
Kurse ergibt sich aus den jeweiligen Kursangeboten, die auf der Webseite von MT aufgefihrt sind.

2.2. Die Angebote sind freibleibend. Der Umfang der zu erbringenden Leistungen wird allein durch die
Auftragsbestétigung festgelegt.

2.3. MT ist berechtigt, fir zu erbringende Leistungen Dritte zu beauftragen.

2.4. Sollte sich bei einem 6ffentlichen Seminar nur ein Kursteilnehmer angemeldet haben, kann MT dem
Kunden das Seminar zum gleichen Preis als individuelles Inhouse Training beim Kunden mit verkiirzter
Seminardauer anbieten oder auf einen ndchsten Seminartermin verweisen. Der Kunde hat in diesem Fall
das Recht, vom Vertrag zuriickzutreten.

2.5. Sollte ein Teilnehmer innerhalb von drei Monaten nach Teilnahme aus dem Unternehmen ausschei-
den, welches das Training finanziert hat, gewahrt MT dem direkten Nachfolger innerhalb von drei Monaten
nach dem Trainingstermin kostenfrei an einem von MT garantierten 6ffentlichen Training gleichen Themas
teilzunehmen. Voraussetzung hierfir ist ein Bestétigungsschreiben des Unternehmens und des ehemali-
gen Teilnehmers, in welchem die genauen Eintritts- und Austrittsdaten bestétigt werden.

2.6. Bei Nichtgefallen eines Trainings gewdhrt MT eine Neuauswahl eines Kurses aus dem Programm,
sofern dieses MT am ersten Trainingstag bis 13:00 Uhr mitgeteilt wird. Ein Anspruch auf Riickerstattung
von eventuellen Fahrtkosten, Hotelkosten oder sonstigen entstandenen Kosten besteht in diesem Falle
nicht, sofern MT diesen Umstand nicht grob fahrldssig oder vorsétzlich herbeigefihrt hat.

2.7. Individuelle Trainings sind von der Regelung der Absétze 2.5. und 2.6. ausgeschlossen.

§3. Anmeldung

3.1. Inre Anmeldung fir ein Training kénnen Sie schriftlich per Post, Telefax oder per E-Mail an
info@medienreich.com senden. Telefonische Anmeldungen kénnen wir leider nicht entgegennehmen.
3.2. Anmeldungen werden in der Reihenfolge ihres Eingangs beriicksichtigt. Ist ein Training zum ge-
wiinschten Termin bereits belegt, werden Sie auf die Warteliste gebucht. Eine automatische Umbuchung
auf den ndchsten freien Termin wird seitens MT nicht vorgenommen.

3.3. Die Auftragsbestatigung erhalten Sie nach der Auftragsbearbeitung. Hieraus konnen Sie die Beginn-
und Endezeiten des Trainings, den Schulungspreis und eventuell besondere Hinweise entnehmen.

3.4. Sollten Sie innerhalb von einer Woche keine Benachrichtigung seitens MT erhalten, so bitten wir Sie,
sich mit uns in Verbindung zu setzen.

§4. Absagen/Stornierung

4.1. Stornierungen sind schriftlich per Post, Telefax oder per E-Mail an uns zu senden.

4.2. Geht die Absage bis zu zwei Wochen vor Trainingsbeginn MT zu, erfolgt sie gebihrenfrei.

4.3. Erfolgt die Stornierung weniger als 14 Kalendertage vor Schulungsbeginn bei MT ein, so wird 50%
der vereinbarten Trainingsgebihr als Stornogebihr berechnet.

4.4. Bei einer Absage sieben Kalendertage vor dem Beginn der MaBnahme und spéter wird die volle
Vergiitung berechnet.

4.5. Die unter Punkt 4.3 und unter Punkt 4.4 angegebenen Stornierungsgebtihren gelten auch, wenn die
Schulung auf einen spéteren Zeitpunkt umgebucht wird.

4.6. Muss aus organisatorischen Griinden ein Schulungstermin seitens der MT abgesagt werden, so
kdnnen dber die Schulungsgebihr hinausgehende Anspriiche nicht geltend gemacht werden.

4.7. Dem Kunden ist es gestattet, auch einen Ersatzteilnehmer zu stellen. In diesem Falle entfallen even-
tuelle Stornogebtihren.

4.8. Bei einer Stornierung ist es dem Kunden gestattet, unter Anrechnung der Stornogebihren an einem
anderen stattfindenden offenen Training teilzunehmen.

§5. Vergiitung

5.1. Die Vergiitung richtet sich nach der jeweils giiltigen Preisliste inclusive der giltigen Mehrwertsteuer.
Die Gebuhr enthdlt bei ganztdgigen Veranstaltungen in unseren Schulungsrdumen ein Mittagessen sowie
Pausenverpflegung. Reise- und Hotelkosten des Referenten fiir im Hause des Kunden durchgeftihrte Trai-
nings sind nicht im Preis enthalten und werden separat berechnet.

5.2 . Eine Rabattgewahrung bei der Anmeldung mehrerer Teilnehmer ist nur nach vorheriger Absprache
mit MT mdglich, wenn sie von einer anmeldenden Person/Stelle erfolgt und eine Sammelrechnung erstellt
wird. Die Treuerabatte gelten nur fiir die Trainings, die in der Termin- und Preisliste von MT ausgeschrie-
ben sind. Inhouse und Firmen Trainings sind von dieser Rabattgewdhrung ausgeschlossen.

§6. Kundenverpflichtung/Zahlung/Verzug

6.1. Die Schulungsanordnungen und Schulungszeiten sind verbindlich. VerstoBe kénnen zum Ausschluss
vom Training fahren. Ein Anspruch auf Gebihrenerstattung entsteht dadurch nicht.

6.2. Die Vergiitung ist mit dem Zugang der Rechnung fallig und durch Uberweisung auf das Konto von
MT innerhalb von sieben Tagen zu zahlen. Im Falle des Zahlungsverzuges gelten die gesetzlichen Regeln.
Gerdt der Kunde in Zahlungsverzug gemdB § 284 BGB, hat er den entsprechenden Verzugsschaden zu
ersetzen. Die Geltendmachung eines weitergehenden Schadens behdlt sich MT vor. Ein Aufrechnungs-
recht steht dem Kunden nur zu, soweit seine Gegenforderung rechtskréftig festgestellt, unbestritten oder
anerkannt ist.

§7. MindeslteilnehmerzahI/ﬂnderungsvorhehall

7.1, MT ist berechtigt sich vom Vertrag zu I6sen, falls bei 6ffentlichen Trainings die Mindestteilnehmer-
zahl nicht erreicht wird, der Referent unvorhergesehen zum Trainingstermin arbeitsunféhig erkrankt ist
und ein Ersatzreferent nicht mehr organisiert werden kann oder ein unvorhergesehenes Leistungshinder-
nis vorliegt, sofern dieses nicht durch zumutbare Aufwendungen tiberwunden werden kann und MT das
Hindernis nicht zu vertreten hat.

7.2. Im Falle des Absatzes 7.1. wird MT den Kunden unverziglich, bei Nichterreichen der Mindest-
teilnehmerzah! spatesten finf Werktage vor Trainingsbeginn iiber die Nichtverfiigbarkeit des Trainings
informieren und dem Kunden unverziiglich die Vergiitung erstatten.

7.3. MT ist berechtigt, den Trainingsinhalt und -aufbau dem Stand der Entwicklung anzupassen und
aktualisierend zu dndern.

§8. Haftung/Gewdhrleistung

8.1. Bei Kursausfall oder Terminverschiebung haftet MT nicht fiir eventuell angefallene Reise- und Uber-
nachtungskosten sowie von durch Arbeitsausfall entstehende Auslagen. Fir mittelbare Schaden, insbe-
sondere entgangenem Gewinn oder Anspriiche Dritter, wird nicht gehaftet. Dies gilt nicht bei Vorsatz oder
grober Fahrldssigkeit von MT.

8.2. Schadensersatzanspriiche ggi. MT, der gesetzlichen Vertreter und Erfiillungsgehilfen werden nur bei
Nachweis von Vorsatz oder grober Fahrldssigkeit anerkannt.

8.3. Die Haftung beschrénkt sich im Fall grober Fahrldssigkeit und bei Fehlen einer Beschaffenheit, fir
die MT eine Garantie (ibernommen hat, auf den vorhersehbaren Schaden, der durch die verletzte Pflicht
oder die Garantie verhindert werden sollte.

8.4. Diese Haftungsbegrenzungen gelten nicht bei der Haftung fiir Personenschaden. Fiir Schéden aus der
Verletzung des Lebens, des Kdrpers oder der Gesundheit haftet MT unbeschrénkt bei einem Verschulden.
Der Einwand des Mitverschuldens bleibt offen.

8.5. Fir alle Anspriiche gegen MT auf Schadensersatz oder Ersatz vergeblicher Aufwendungen bei ver-
traglicher und auBervertraglicher Haftung gilt, auer in Féllen des Vorsatzes oder bei Personenschaden,
eine Verjahrungsfrist von einem Jahr nach Kenntnis der Anspruchsgrundlage. Die Verjéhrung tritt spétes-
tens 2 Jahre nach Entstehung des Anspruchsgrundes ein.

8.6. Fur vom Teilnehmer wéhrend einer Schulung eingebrachte Gegenstédnde wird keine Haftung iber-
nommen.

8.7. Unterricht und Ubungen werden so gestaltet, dass ein aufmerksamer Teilnehmer das gesteckte Trai-
ningsziel erreichen kann. Fiir den Eintritt des Trainingserfolges haftet MT nicht.

§9. Geistiges Eigentum

Alle Rechte fiir die ausgehdndigten Trainingsunterlagen und Programme sind urheberrechtlich geschiitzt.
Alle Rechte, auch Ubersetzungen, Vervielféltigungen und Nachdruck von Schulungsunterlagen und Schu-
lungsprogrammen, auch auszugsweise, sind MT vorbehalten. Ohne schriftliche Genehmigung von MT
diirfen keine Reproduktionen vorgenommen werden. Dieses bezieht sich ausdriicklich auch auf die im
Rahmen des Trainings zur Verfiigung gestellte Software.

§10. Datenschutz/Geheimhaltungspflicht

10.1. MT weist den Kunden darauf hin, dass die im Rahmen des Vertragsschlusses aufgenommenen
Daten gemaB dem Bundesdatenschutzgesetz (BDSG) und dem Telemediengesetz (TMG) von MT zur Er-
fiillung der Verpflichtungen aus dem Vertrag erhoben, verarbeitet und genutzt werden.

Dies gilt insbesondere fiir die personenbezogenen Daten des Kunden, d.h. seine Kontaktinformationen,
einschlieBlich Namen, Telefon- und Telefaxnummern sowie E-Mail-Adressen. Der Kunde erklart sich aus-
driicklich damit einverstanden, dass MT die vorbezeichneten Daten erheben, speichern und nutzen darf.
10.2. Der Kunde erkldrt sich ferner damit einverstanden, dass die vorgenannten Daten z.B. fiir Werbung,
E-Mail-Informationen, Newsletter und/oder zur Marktforschung durch MT genutzt werden kénnen.
Personenbezogene Kunden- und Abrechnungsdaten kdnnen im Rahmen der bestehenden Geschéftsbezie-
hung verarbeitet und genutzt werden und an Kooperationspartner, Subunternehmer, Vertriebspartner so-
wie Bevollméchtigte von MT und seiner verbundenen Unternehmen zum Zwecke der gemeinschaftlichen
Geschéftsaktivitdten, der Kundenbetreuung, der Kundeninformation und des Vertriebs, weitergegeben
werden. Hiermit erkldrt sich der Kunde ausdriicklich einverstanden.

10.3. Der Kunde hat das Recht, die von ihm erteilte Einwilligung in Bezug auf die Verwendung und Nut-
zung seiner personenbezogenen Daten mit Wirkung fir die Zukunft jederzeit zu widerrufen.

10.4. Der Kunde wird alle Informationen vertraulich behandeln, die ihm im Rahmen der Abwicklung
dieses Vertragsverhdltnisses zugdnglich gemacht werden.

§11. Schlusshestimmung/Salvatorische Klausel

11.1. Es gilt das Recht der Bundesrepublik Deutschland. Die Geltung des UN-Kaufrechts wird ausge-
schlossen.

11.2. AusschlieBlicher Gerichtsstand ist Bielefeld. Dies gilt auch, wenn der Kunde keinen allgemeinen
Gerichtsstand im Inland hat, ein Kunde nach Vertragsabschluss seinen Wohnsitz oder gew8hnlichen
Aufenthalt in das Ausland verlegt hat oder sein Wohnsitz oder gew8hnlicher Aufenthaltsort zum Zeitpunkt
der Klageerhebung unbekannt ist.

11.3. Alle Streitigkeiten, die sich im Zusammenhang mit dem Dienstleistungsvertrag, der AGB oder tiber
seine Gltigkeit ergeben, werden nach der Schiedsgerichtsordnung der Industrie- und Handelskammer
Bielefeld unter Ausschluss des ordentlichen Rechtsweges endgiiltig entschieden. Das gerichtliche Mahn-
verfahren bleibt aber zuléssig. Der Ort des schiedsrichterlichen Verfahrens ist Bielefeld.

Fir alle Streitigkeiten, die sich zwischen dem Anbieter und einem Verbraucher im 0.g. Zusammenhang
ergeben, kann die allgemeine Schlichtungsstelle ,Zentrum fiir Schlichtung e.V." unter der Adresse www.
verbraucher-schlichter.de angerufen werden.

11.4. Rechte und Pflichten aus diesem Vertrag k6nnen nur nach vorheriger schriftlicher Zustimmung von
MT auf Dritte tibertragen werden.

11.5. Soweit wesentliche Bestimmungen des geschlossenen Vertrages nicht tangiert werden und es zur
Anpassung an aktuelle Entwicklungen erforderlich ist, welche bei Vertragsschluss nicht vorhersehbar
waren und deren Nichtberiicksichtigung die Ausgewogenheit des Vertragsverhdltnisses merklich beein-
trachtigen wiirde, ist eine Anderung dieser AGB zuléssig.

Die AGB konnen auch angepasst, ergénzt oder sonst verdndert werden, soweit dies zur Beseitigung von
etwaigen Schwierigkeiten bei der Durchfiihrung des Vertrages, z.B. aufgrund von nach Vertragsschluss
entstandenen Regelungslicken erforderlich ist, so z.B. wenn sich die Rechtsprechung dndert und eine
oder mehrere Klauseln dieser AGB hiervon betroffen sind.

11.6. Sollte eine Bestimmung dieses Vertrages und/oder seiner Anderungen bzw. Erganzungen unwirk-
sam sein, so wird dadurch die Wirksamkeit des Vertrages im Ubrigen nicht beriihrt.
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